
Revision 4 

 

 

 

FLSP920 Series User Guide 
FS920 - FL920 -  FP920 - FSP920 -  FLP920 -  FLS920 - FLSP920 

 

 

 

               





 

 

Copyrights 

Copyright © 2012 Edinburgh Instruments Ltd. All rights reserved. 

 

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or any 
means electronic or mechanical, including photocopying and recording for any purpose other than the purchaser’s 
personal use without written permission. 

Information in this document is subject to change without notice. While every effort has been taken to make sure 
that the information given is correct, Edinburgh Instruments Limited cannot accept any liability for errors and 
omissions or their consequences. The software described in this document is furnished under a license 
agreement or nondisclosure agreement. The software may be used or copied only in accordance with the terms 
of those agreements. 

 

Edinburgh Instruments Ltd. 

2 Bain Square 

Kirkton Campus 

Livingston 

EH54 7DQ 

UK 

www.edinst.com 

http://www.edinst.com/




Contents 

1 

Contents 

OVERVIEW .................................................................................................................................................... 3 

1. INTRODUCTION TO THE FLSP920 SERIES OF FLUORESCENCE SPECTROMETERS ................................... 4 
1.1. FLSP920 SERIES MODELS ................................................................................................................... 5 
1.2. SPECTROMETER UPGRADES ................................................................................................................ 10 

2. SPECTROMETER COMPONENTS....................................................................................................... 11 
2.1. LIGHT SOURCES............................................................................................................................... 11 
2.1.1. Xe900 Continuous Xenon Lamp ....................................................................................................... 11 
2.1.2. μF920H Xenon Flashlamp ................................................................................................................ 13 
2.1.3. nF920 Nanosecond Flashlamp......................................................................................................... 15 
2.1.4. Other Light Sources.......................................................................................................................... 17 
2.2. MONOCHROMATORS ....................................................................................................................... 17 
2.2.1. Excitation Monochromator.............................................................................................................. 18 
Emission Monochromator................................................................................................................................. 19 
2.2.2. Monochromator Gratings................................................................................................................ 20 
2.3. SAMPLE CHAMBER........................................................................................................................... 21 
2.3.1. Standard Lens Optics ....................................................................................................................... 22 
2.3.2. Mirror Optics and Other Beam Steering Options............................................................................. 23 
2.4. SAMPLE HOLDERS............................................................................................................................ 23 
2.4.1. Standard Single Cuvette Holder....................................................................................................... 23 
2.4.2. Other Sample Holders and Sample Positioning Options .................................................................. 24 
2.5. DETECTORS .................................................................................................................................... 25 
2.5.1. Red Sensitive Photomultiplier in Cooled Housing ............................................................................ 25 
2.5.2. Other Detectors ............................................................................................................................... 26 

3. INTRODUCTION TO F900 SOFTWARE ............................................................................................... 27 
3.1. STARTING F900.............................................................................................................................. 27 
3.2. GENERAL FEATURES OF THE F900 MAIN WINDOW .................................................................................. 27 
3.3. SIGNAL RATE WINDOW .................................................................................................................... 29 
3.4. SETUP MENUS................................................................................................................................ 30 
3.4.1. nF Lamp Setup ................................................................................................................................. 30 
3.4.2. μF Lamp Setup ................................................................................................................................. 31 
3.5. SCAN TYPES AND SCAN PROPERTIES ..................................................................................................... 32 
3.5.1. Spectral Data ................................................................................................................................... 32 
3.5.2. Time‐Resolved Data......................................................................................................................... 36 
3.6. GRAPHICAL PRESENTATIONS AND PLOT OPTIONS..................................................................................... 37 
3.6.1. 2D Data Presentation ...................................................................................................................... 37 
3.6.2. 3D Data Presentation ...................................................................................................................... 39 
3.6.3. Contour Plots ................................................................................................................................... 40 
3.6.4. View Numerical Data....................................................................................................................... 41 
3.7. DATA OPERATION AND ANALYSIS WITH F900......................................................................................... 42 
3.8. SOFTWARE AND HARDWARE OPTIONS .................................................................................................. 43 

4. MAKING SPECTRAL MEASUREMENTS .............................................................................................. 45 
4.1. EMISSION SCANS............................................................................................................................. 46 
4.2. EXCITATION SCANS .......................................................................................................................... 47 
4.3. SYNCHRONOUS SCANS ...................................................................................................................... 48 
4.4. CORRECTION SCANS ......................................................................................................................... 49 
4.4.1. Excitation Correction Scans ............................................................................................................. 50 
4.4.2. Emission Correction Scans ............................................................................................................... 51 
4.5. SPECTRAL ANISOTROPY SCANS............................................................................................................ 53 
4.5.1. Excitation Anisotropy Scans............................................................................................................. 54 
4.5.2. Emission Anisotropy Scans............................................................................................................... 55 



FLSP920 Series User Guide 

 

2                                                     Edinburgh Instruments Ltd 

4.6. EMISSION MAPS..............................................................................................................................57 
4.7. SYNCHRONOUS MAPS.......................................................................................................................59 
4.8. TIPS FOR MAKING GOOD SPECTRAL MEASUREMENTS ...............................................................................60 

5. MAKING TIME RESOLVED MEASUREMENTS .....................................................................................65 
5.1. KINETIC MEASUREMENTS...................................................................................................................67 
5.2. MANUAL TIME RESOLVED MEASUREMENTS – MCS .................................................................................68 
5.2.1. Operation of the μF900H .................................................................................................................68 
5.2.2. Measurement of a Phosphorescence Decay ....................................................................................69 
5.2.3. Measurement of the Instrument Response Function.......................................................................70 
5.3. MANUAL TIME RESOLVED MEASUREMENTS – TCSPC...............................................................................71 
5.3.1. Operation of the nF920....................................................................................................................71 
5.3.2. Measurement of a Fluorescence Decay ...........................................................................................72 
5.3.3. Measurement of the Instrument Response Function.......................................................................74 
5.4. MULTIPLE TIME RESOLVED MEASUREMENTS...........................................................................................74 
5.5. TRES‐MAP MEASUREMENTS..............................................................................................................75 
5.5.1. Excitation TRES‐Map Measurements...............................................................................................75 
5.5.2. Emission TRES‐Map Measurements.................................................................................................76 
5.6. TIME RESOLVED ANISOTROPY MEASUREMENTS .......................................................................................77 
5.7. TIPS FOR MAKING GOOD LIFETIME MEASUREMENTS.................................................................................80 

6. DATA OPERATIONS ON SPECTRAL DATA ..........................................................................................85 
6.1. ADD, SUBTRACT, MULTIPLY, DIVIDE .....................................................................................................85 
6.2. APPEND.........................................................................................................................................86 
6.3. SCALE, NORMALISE, SUBTRACT BASELINE, CROP RANGE ............................................................................86 
6.4. SMOOTH........................................................................................................................................88 
6.5. DIFFERENTIATE AND INTEGRATE...........................................................................................................89 
6.6. ANISOTROPY...................................................................................................................................90 
6.7. SPECTRAL CORRECTION......................................................................................................................91 

7. DATA OPERATIONS AND ANALYSIS ON TIME RESOLVED DATA .........................................................93 
7.1. ADD, SUBTRACT, MULTIPLY, DIVIDE .....................................................................................................93 
7.2. SCALE, NORMALISE, SUBTRACT BASELINE, CROP RANGE ............................................................................93 
7.3. REVERSE ........................................................................................................................................93 
7.4. ANISOTROPY...................................................................................................................................94 
7.5. TAIL FIT ANALYSIS ............................................................................................................................95 
7.6. RECONVOLUTION FIT ANALYSIS ...........................................................................................................98 
7.7. AUTOCORRELATION ........................................................................................................................102 
7.8. TRES DATA SLICING .......................................................................................................................102 

FORMULAS AND DEFINITIONS....................................................................................................................103 

GLOSSARY .................................................................................................................................................105 

INDEX........................................................................................................................................................106 
 



Introduction to the FLSP920 Series of Fluorescence Spectrometers 

Photonics Division                                                                                            3 

Overview 
 

The FLSP920 Series of Fluorescence Spectrometers enable steady-state, fluorescence lifetime and 
phosphorescence lifetime measurements.  

Read this document if you plan to use the spectrometer to make measurements or use the software to analyse 
your measurement results. It describes the spectrometer components, the software you use to control the 
spectrometer and how to make spectral and lifetime measurements. It also describes how to use the software to 
analyse the results. 

This User Guide coveres the operation of the standard components, with two exceptions: Double 
monochromators and anisotropy measurements. Double monochromators are a popular alternative to the 
standard single monochromators, they are mentioned in chapters 1 and 2. Anisotropy measurements require the 
optional polariser upgrade. The acquisiton of anisotropy measurements is covered in chapters 4 and 5 and the 
data operation and analysis procedures are explained in chapters 6 and 7. 

 

 

More Information 
For details on how to install and setup the spectrometer, refer to the FLSP920 Series Installation Guide. 

For more detail on all the spectrometer components (standard and optional components), see the FLSP920 
Series Reference Guide. This contains instructions on how to maintain, clean, and replace component parts as 
well as specification sheets and software references. 
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1. Introduction to the FLSP920 Series of 
Fluorescence Spectrometers 

The FLSP920 Series is a series of modular software-controlled spectrometers for the acquisition of steady state 
and time resolved photoluminescence. They can measure: 

 Fluorescence and phosphorescence spectra 

 Fluorescence and phosphorescence lifetimes 

Data can be obtained in a wide spectral range, from the ultraviolet to near-infrared, with single photon counting 
sensitivity. The spectrometer series combines extremely high sensitivity with high spectral and temporal 
resolution. 

The FLSP920 Series of Fluorescence Spectrometers is ideal for demanding applications in such areas as: 

 Photophysics 

 Photochemistry 

 Biophysics 

 Materials research 

An FLSP920 Series spectrometer has the following main components: 

 Light Source – an excitation source to generate photoluminescence from the sample 

 Excitation Monochromator – for the selection of specific monochratic light from the full spectrum of the 
excitation source 

 Sample Chamber – for optical components and sample holders 

 Emission Monochromator – for the selection of specific monochromatic light from the full spectrum of the 
sample emission 

 Detector – detects the photon flux of the sample emission at the selected wavelength 

 dedicated PC – houses data acquisition cards and is loaded with spectrometer operating software F900. 

Depending on the type of measurments you want to make, different light sources are used together with different 
data acquisition techniques: 

Measurement Type Standard Light Source Data Acquisition Technique 

Spectral masurements Continuous xenon lamp (Xe900) Single Photon Counting 

Time resolved measurements in 
the microsecond to second range 

Microsecond flashlamp (μF920H) Multi-channel scaling (MCS) for 
time resolved photon counting 

Time resolved measurements in 
the pico- to nano-second range 

Nanosecond flashlamp (nF920) Time Correlated Single Photon 
Counting (TCSPC) 

 

The following section (chapter 1.1) introduces each of the seven models in the FLSP920 Series of fluorescence 
spectrometers. Your own spectrometer may differ from those shown in respect to light sources, detectors and 
optional accessories. Upgrade options are listed in chapter 1.2 on page 10. For a detailed description on those 
options refer to the FLSP920 Series Reference Guide. 
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1.1. FLSP920 Series Models 
The seven FLSP920 Series models are listed below. 

FS920 
This is a spectrometer for the acquisition of fluorescence spectra and fluorescence kinetic measurements. The 
FS920 is the world’s most sensitive steady-state fluorescence spectrometer, with a specified signal-to-noise ratio 
of the Water Raman signal of 6000:1. 

Figure 1-1a shows the layout of the standard version of the FS920 with single grating monochromators; Figure 
1-1b shows the FS920 with double grating monochromators. 

Component Standard 

Light Source Xe900 continuous xenon lamp 

Detector Single Photon Counting PMT  

Data Acquisition Card PCS900 

Acquisition Technique Single Photon Counting (spectral scanning, kinetic measurements) 
 

                                                     

                                     

Figure 1-1: General layout of the FS920 

a 

b 
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FL920 
The FL920 is a dedicated spectrometer for the acquisition of fluorescence decay kinetics the time range from 
picoseconds to microseconds, based on the technique of Time Correlated Single Photon Counting (TCSPC). 

Component Standard 

Light Source nF920 nanosecond flashlamp, EPLs and EPLEDs as options 

Detector Single Photon Counting PMT  

Data Acquisition Card TCC900 

Acquisition Technique TCSPC (fluorescence decay acquisitions) 
 

                                                

Figure 1-2: General layout of the FL920 

FP920 
The FP920 is a dedicated spectrometer for the acquisition of phosphorescence decay kinetics in the time range 
from microseconds to seconds, based on the technique of multi-channel scaling (MCS). 

Component Standard 

Light Source μF920H microsecond flashlamp 

Detector Single Photon Counting PMT  

Data Acquisition Card PCS900 

Acquisition Technique MCS (phosphorescence/lanthanide decay acquisitions) 
 

                                                   

Figure 1-3: General layout of an FP920 
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FSP920 
The FSP920 is a steady state and phosphorescence lifetime spectrometer. It can be used to measure 
fluorescence and phosphorescence spectra, as well as phosphorescence decay kinetics.  

Component Standard 

Light Sources Xe900 continuous xenon lamp, μF920 microsecond flashlamp 

Detector Single Photon Counting PMT 

Data Acquisition Card PCS900 

Acquisition Technique MCS (spectral scanning and phosphorescence/lanthanide decay acquisitions) 

                                            

Figure 1-4: General layout of an FSP920 

FLP920 
The FLP920 is a dedicated instrument for the acquisition of fluorescence and phosphorescence kinetics 
throughout all time ranges (picoseconds to seconds). 

Component Standard 

Light Sources μF920H microsecond flashlamp, nF920 nanosecond flashlamp, EPLs/EPLEDs  

Detector Single Photon Counting PMT  

Data Acquisition Card PCS900, TCC900 

Acquisition Technique MCS and TCSPC (fluorescence and phosphorescence decay acquisitions) 

                                                

Figure 1-5: General layout of an FLP920 
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FLS920 
The FLS920 is a combined steady state and time resolved fluorescence spectrometer. 

Component Standard 

Light Sources Xe900 continuous xenon lamp, nF920 nanosecond flashlamp, EPLs and 
EPLEDs as options  

Detector Single Photon Counting PMT  

Data Acquisition Card PCS900, TCC900 

Acquisition Technique Single Photon Counting, MCS and TCSPC  
(spectral scanning, kinetic measurements, fluorescence decay acquisitions) 

 

                                             

Figure 1-6: General layout of an FLS920 

 

 

FLSP920 
The FLSP920 is a complete fluorescence laboratory in a single instrument. It combines all the features of the 
FS920, FL920, and FP920. 

Figure 1-7a shows the layout of the standard version of the FLSP920 with single grating monochromators, Figure 
1-7b shows the FLSP920 with the popular upgrade of double grating monochromators. 

 

Component Standard 

Light Sources Xe900 continuous xenon lamp, μF920 microsecond flashlamp, 
nF920 nanosecond flashlamp, EPLs and EPLEDs as options  

Detector Single Photon Counting PMT  

Data Acquisition Card PCS900, TCC900 

Acquisition Technique Single Photon Counting, MCS and TCSPC  
(spectral scanning, kinetic measurements, fluorescence and phosphorescence 
decay acquisitions) 
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Figure 1-7: General layout of an FLSP920  
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b 
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1.2. Spectrometer Upgrades 
The fluorescence spectrometers listed in Section 1.1 are standard configurations. Various upgrades, 
modifications, and enhancements are also available, giving the FLSP920 Series the flexibility to be used with a 
wide range of specific applications and sample requirements. 

Common upgrades and enhancements include: 

 Double monochromators with increased stray light performance for better measurements of highly 
scattering samples 

 Additional emission monochromators to form a “T” geometry, enabling more than two detectors to be 
permanently installed (or more than three when using double monochromators) 

 Polarisers for automatic acquisition of fluorescence anisotropy data 

 EPLs (picosecond pulsed diode lasers) to increase temporal resolution for samples with picosecond 
fluorescence decays 

 EPLEDs (picosecond pulsed LEDs) to increase pulse energy and pulse repetition rate for faster 
fluorescence lifetime measurements 

 Alternative data acquisition cards for increased temporal resolution of samples with decay in 
nanosecond time range 

 Gated photomultipliers for better discrimination between (long) phosphorescence decay and strong 
(short) fluorescence and/or strong sample scattering 

 Near Infrared detectors 

Additionally, a range of sample holders and sample cooling options are available: 

 Cuvette holders with options for water circulation (for cooling or heating) with a temperature probe 

 Magnetic stirrers 

 Front face sample holders on slides, rotational stages, X-Y stages 

 Thermo-electrically temperature-controlled cuvette holder with magnetic stirrer option 

 EPR dewar option for cooling at liquid nitrogen temperature 

 Cryostat options (Helium or Nitrogen) 

 Multi-position sample holders, with water circulation or thermo-electric based temperature control 

 Plate Reader attachment 

 Fibre attachments 

 Fibre couplers to microscopes 

 Integration Sphere 

 Absorption accessory 

 X-ray excitation 

For more details on these options, refer to the FLSP920 Series Reference Guide. 
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2. Spectrometer Components 
The following sections describe the FLSP920 Series standard components. For details on other non-standard 
components, see the FLSP920 Series Reference Guide. 

2.1. Light Sources 
There are three standard light sources in the FLSP920 spectrometer series: 

 A 450W continuous xenon arc lamp for continuous sample excitation (FLSP, FLS, FSP, FS 
spectrometers) 

 A low repetition rate pulsed 60W xenon flashlamp for pulsed sample excitation in multichannel scaling 
experiments (FLSP, FSP, FLP, FP spectrometers),  

 A high repetition rate nanosecond pulsed flashlamp for Time Correlated Single Photon Counting 
experiments (FLSP, FLS, FLP, FL spectrometers). 

 

2.1.1. Xe900 Continuous Xenon Lamp 

The standard light source for steady state applications is a 450W xenon arc lamp, as shown in Figure 2-1. It 
produces “white” light composed of a continuum superimposed with lines. The optimal spectral range extends 
from below 250nm to more than 1000nm. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-1: Xe900 Xenon Lamp 

 
The Xe900 has a separate power supply connected to the lamp head by a well-shielded power cable. The lamp 
has an automated start-up procedure, a run-time monitor on the rear of the power supply, failure indicators and a 
voltage/current display on the front of the power supply unit. 

The emission of the arc is focussed onto the slit of the excitation monochromator using an adjustable lens system. 
The rear of the xenon lamp head has two adjustment screws (horizontal, vertical) for the xenon bulb and three 
adjustment screws (horizontal, vertical, focus) for a reflector mounted behind the bulb for additional light 
collection. 

adjustable lens assembly 

power inlet, connection to 
the Xe900 power supply 

lamp alignment screws 

mirror alignment  screws 
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Xe900 Output Spectrum 
Figure 2-2 shows the spectral output of the 450W xenon arc lamp, in relative power units. This is the spectral 
output of the xenon lamp only, un-affected by the throughput function of the excitation monochromator. 

Figure 2-2: Spectral Output of the 450W Xenon Arc Lamp 

 

The xenon lamp can be fitted with an ozone-free bulb or with an ozone generating bulb (optional). When fitted 
with an ozone generating bulb, the spectral output in the UV spectral range is enhanced and the lower 
wavelength limit shifts from about 250nm to 230nm. Further enhancement in the UV can be achieved by selecting 
special UV gratings for the excitation monochromator. 

 

WARNING! 

When working with ozone-generating bulbs, an air extraction system must be fitted to the 
lamp head. 

 

Maintenance 
The Xe900 is mostly maintenance-free. Optical alignment is made as part of the installation process: see the 
FLSP920 Series Installation Guide for details.  

The xenon bulb has an average lifetime of 2000 hours (1000 hours guaranteed). For instructions on how to 
change and align the bulb, refer to the FLSP920 Series Installation Guide for details. 



Spectrometer Components 

Photonics Division                                                                                            13 

2.1.2. μF920H Xenon Flashlamp 

The μF920H is a compact 60W xenon flashlamp, triggered by the spectrometer controller. The output is focussed 
by an adjustable lens assembly onto one of the entrance slits in the spectrometer’s excitation monochromator. 

 

                                               

Figure 2-3: µF920H Xenon Flashlamp 

 

The µF920H is optimised for multi-channel scaling (MCS) lifetime measurements, with a narrow optical pulse 
width and a pulse repetition rate of between 0.1Hz and 100Hz. 

For some applications (for example, time-gated spectral scanning), the µF920H lamp can be used as an 
excitation source for spectral scans.  

When using the µF920H, your samples should have intrinsically long lifetimes since the spectrometer uses the 
highly sensitive single photon counting mode for spectral scanning. With a repetition rate of 100Hz and a typical 
pulse width of 1µs, the number of instantaneous photons counted per dwell time is limited. 

adjustable lens assembly 

connector panel with 
mains inlet, trigger input 
(BNC) and ON/OFF 
switch on the rear 
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µF920H Output Spectrum 
The typical output spectrum of the µF920H is shown in Figure 2-4. Compared to the spectrum of a continuous 
xenon lamp (see Section 2.1.1 Xe900 Continuous Xenon Lamp on page 11), the microsecond pulsed xenon 
flashlamp has an optical output that is more line-structured and has comparatively higher content of UV output. 
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Figure 2-4: Spectral Output of the Xenon Flashlamp 

 

µF920H Pulse Profile 
Figure 2-5 shows the temporal output of the µF920H flashlamp, measured at 300nm (blue), 450nm (green) and 
600nm (red). The typical pulse width is 2μs. Note that the shape and the tail is somewhat wavelength dependent. 

 

Figure 2-5: Temporal Output of μF920H Flashlamp 
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2.1.3. nF920 Nanosecond Flashlamp 

The nF920 is an all-metal triggered flashlamp with a fast switching thyratron, spark gap and charging resistor. The 
flashlamp can produce nanosecond and sub-nanosecond optical pulses with repetition rates up to 50kHz. It is the 
only discharge light source available with narrow pulses of sufficiently high repetition rate to be suitable for 
TCSPC measurements. However, upgrades picosecond diode lasers and LEDs are available, refer to the 
FLSP920 Series Reference Guide for EPLs and EPLEDs, respectively. 

Depending on the discharge gas, the nF920 can produce a broad spectral continuum. This makes the nF920 a 
suitable light source in fluorescence lifetime spectrometers. 

The nF920 ensures maximum electrical-to-optical energy conversion during a clean, controlled spark discharge. 
The compact metal body ensures robustness and effectively shields any RF emission from the spark discharge at 
source. Stray capacitance is kept to a minimum, ensuring maximum photon yield of the light pulses with minimum 
pulse width and tail. 

 

                                       

Figure 2-6: nF920 Nanosecond Flashlamp 

 

nF920 Power Control Unit 
The nF920 lamp is powered and controlled by a dedicated power supply unit. The nF920 power control unit 
delivers a high voltage for the gas discharge, heater current for the thyratron cathode, trigger pulses for the 
thyratron discharge trigger and power for the fans that control the thyratron temperature. The power control unit 
connects to spectrometer controller so that the high voltage and the trigger frequency can be controlled and 
monitored by the spectrometer software. The software also monitors the lamp’s gas pressure. 

access flange 
(for electrode cleaning) 

fibre port 

trigger input 

high voltage connector 

thyratron heater 
connector 

lens adjustment 

fan 
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START Photomultiplier Box 
The synchronisation photomultiplier monitors the optical pulses generated by the flashlamp via optical fibre. The 
optical pulses are converted into electrical pulses which are delivered to the timing electronics of the lifetime 
spectrometer where they are used as START pulses in TCSPC measurements.  

 

nF920 Filler Gas 
The nF920 can use many filler gases and gas mixtures: typically pure hydrogen and nitrogen are used. The 
discharge chamber is sealed from other lamp components by Pyrex insulators and O-rings to give excellent 
vacuum integrity over a wide pressure range. 

Standard vacuum couplings are fitted for connection to the gas pump and a fibre optic interface connects the 
discharge chamber to the synchronisation photomultiplier. 

For details on filler gas tolerance ranges and standard settings, refer to the FLSP920 Series Reference Guide. 

 

Maintenance 
The nF920 must be maintained frequently to ensure stable operation and best performance. This involves 
cleaning the electrodes, aligning the spark gap and readjusting the rear reflector. Refer to the FLSP920 Series 
Reference Guide for details. 

 

nF920 Output Spectrum 
The typical output spectra of the nF920 for hydrogen, deuterium and nitrogen as filler gases are shown in Figure 
2-7. This is the spectral output of the flashlamp only, un-affected by the throughput function of the excitation 
monochromator. 
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Figure 2-7: Spectral Output of the Nanosecond Flashlamp for H2, N2 and D2 

P
ho

to
n 

O
ut

pu
t /

 a
.u

. 

N2 

D2 

H2 



Spectrometer Components 

Photonics Division                                                                                            17 

nF920 Pulse Profile 
Figure 2-8 shows typical instrumental response functions of the nanosecond flashlamp for different filler gases 
(measured with TCSPC, in semi-logarithmic plots). Note that these are typical curves – characteristics can vary 
with operating conditions. 

 

Figure 2-8: Temporal Output (Instrumental Response Functions) of the nF920 for different filler gases 

 

 

2.1.4. Other Light Sources 

For details on other light sources, refer to the FLSP920 Series Reference Guide. 

2.2. Monochromators 
A monochromator transmits a selectable narrow band of wavelengths of light from a wider range of wavelengths 
available at the input. Every FLSP920 Series of fluorescence spectrometers has at least two monochromators: an 
excitation monochromator and an emission monochromator. These can be either single-grating or double-grating 
monochromators, depending on your configuration. You can also add an additional emission monochromator to 
form a “T” geometry, enabling more than two detectors permanently installed. See the FLSP920 Series 
Reference Guide for details. 

FLSP920 Series of fluorescence spectrometers use symmetric Czerny-Turner type monochromators, specifically 
designed to meet the requirements of the modular concept of the spectrometer. The monochromators have two 
chambers: 

 An upper optical chamber coated with absorbent optical grade paint. It is fitted with baffles and shields to 
minimise reflections of scattered light on shiny surfaces and is sealed against ambient light for “single 
photon integrity” 

 The lower chamber contains mechanical and electrical components 

The focal length of the monochromators are 300mm with an F-number of 4.1. They are fitted with one (single 
monochromators) or two (double monochromators) grating turrets, each one carrying up to three gratings. The 
monochromators also have several computer-controlled slits, swing mirrors and shutters. 

When you switch on the spectrometer, the monochromators calibrate by finding defined positions for both the 
grating turrets and slit mechanism. 

 

Nitrogen Deuterium Hydrogen 
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2.2.1. Excitation Monochromator 

The single-grating excitation monochromator has two entrance ports for lamps and one exit port mounted to the 
spectrometer’s sample chamber: 

          

 

Figure 2-9:  TMS300-X Single-Grating Excitation Monochromator 

 

Entrance port B is fitted with a computer controlled shutter. Although typically configured for the Xe900 continuous 
xenon lamp, it may also be used for the μF920H microsecond flashlamp. 

 

                  

Figure 2-10: Schematic of Single-Grating Excitation Monochromator 

 

entrance slit “A” 

entrance port “B” 

exit port 

excitation shutter 
assembly swing mirror 

   grating turret 

entrance port “A” 

entrance port “B” 

exit port  
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Swing Mirror Assembly 
If three lamps are required, a swing mirror assembly is attached to the monochromator as shown in Figure 2-11 
below, allowing for a third entrance port. 

 

 

Figure 2-11: TMS300-X with Swing Mirror Assembly 

 

 

Emission Monochromator 

The single-grating emission monochromator has one input port connected to the sample chamber and two exit 
ports that can be connected to different detectors. 

                                             

Figure 2-12: TMS300-M Single-Grating Emission Monochromator 

 

Unlike excitation monochromators, the emission monochromator’s shutter is not computer-controlled. Instead, it is 
directly interlocked to the sample chamber lid and front hatch. This ensures the detectors are protected against 
ambient light exposure. 

entrance port “A” 

entrance port “B” 

exit port  

entrance port “C” 

exit port “A” 
entrance port 

exit port “B” 
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Figure 2-13: Schematic of Single-Grating Emission Monochromator 

 

A computer-controlled swing mirror selects the detector in use. The standard emission monochromator can be 
fitted with two detectors.  

A special single-grating emission monochromator is available for imaging applications. This monochromator has 
exit port B fitted with the standard slit assembly, whereas exit port A has no slit and is reserved for a CCD 
camera. The swing mirror assembly is in a different position so that the image for port A is outside the 
monochromator body, at the active area of the CCD camera. 

 

2.2.2. Monochromator Gratings 

The monochromator grating determines the spectral coverage and spectral resolution (grating groove density), 
the efficiency of the optical throughput (grating optimisation wavelength / blaze), stray light and polarisation 
effects (type of grating – holographic or ruled). The ratings for the standard gratings for excitation and emission 
monochromator, respectively, are shown in the table below: 

Monochromator Groove Density Mechanical 
Wavelength Coverage 

Optimisation 
Wavelength 

Dispersion 

single-grating  
excitation monochromator 

1800 grooves/mm 200nm - 900nm 250nm 
(holographic) 

1.8nm/mm 

single-grating 
emission monochromator 

1800 grooves/mm 200nm - 900nm 500nm  
(ruled) 

1.8nm/mm 

optional double-grating  
excitation monochromator 

1200 grooves/mm 200nm - 900nm 300nm 
(ruled) 

1.35nm/mm 

optional double-grating 
emission monochromator 

1200 grooves/mm 200nm - 900nm 500nm  
(ruled) 

1.35nm/mm 

 

Some applications may require additional or alternative gratings. In particular applications in the ultraviolet or in 
the near infrared spectral range require gratings of different specifications. See the FLSP920 Series Reference 
Guide for details on optional gratings. 

exit port “B” 

entrance slit  exit port “A” 

interlock shutter 

swing mirror 

grating turret 
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2.3. Sample Chamber 
The central component of the FLSP920 Series spectrometer is the sample chamber. This is a large hexagonal 
box sub-divided into the upper sample chamber, and a lower section containing control electronics. 

The sample chamber has two access ports for routine access to the sample and mechanical/optical components 
inside the compartment: A circular lid that covers a 230mm diameter round access hole on the top of the chamber 
and a 260mm wide front hatch. Both access ports are interlocked, i.e. as soon as one of the two lids is lifted the 
shutter in the emission monochromator will close to protect the detector(s) against ambient light. 

A third slot on top of the sample chamber accepts a filter holder for the excitation beam. This is not interlocked as 
the aperture is small and the ambient light entering the sample compartment is minimal. 

To minimise stray light, the interior of the sample chamber is coated with a highly absorbing optical grade black 
paint. Take care not to damage the fragile paint or spill liquids or powders into the sample chamber as this will be 
difficult to clean off without adversely affecting the paint. 

 

 

Figure 2-14: Sample Chamber, shown with optional polarisers and laser coupling flange 

The sample chamber has four beam access ports, each 90o apart. This allows for a variety of configuration 
options such as “T”- geometry (with two emission arms pointing in opposite directions) or “X”-geometry with two 
excitation arms in addition to the two emission arms. The optical beam height within the sample compartment is 
82mm. 

Attenuator 
The standard sample chamber contains an attenuator. This is a horizontal slit of variable width to attenuate the 
amount of light reaching the sample. The location of this arrangement is so that the effect on changing the spot 
size at the sample is minimal. 

 

excitation beam emission beam 

attenuator 

excitation 
polariser 

emission 
polariser 

reference 
detector 

cable and tube 
feed-through 
holes sample holder 
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Reference Detector 
The standard sample chamber contains a reference detector behind the attenuator. The reference detector 
monitors a fraction of the light incident at the sample position. The output of the reference detector is used to 
correct excitation spectra.  

The beam splitter that diverts a fraction of the excitation beam to the reference detector is specially mounted in a 
way that the angles in respect to the vertical polarisation plane and to the horizontal beam polarisation plane are 
identical. This eliminates polarisation effects that would otherwise affect the correction. 

 

Sample Chamber Options 
The sample chamber in Figure 2-14 shows the standard sample chamber, fitted with standard components as 
well as two popular options: polarisers for the excitation and emission beam path and an EPL laser coupling 
flange (including a lens for laser beam focussing). 

Two special versions of the sample chamber are available: One with a 120mm diameter hole in the base of the 
sample chamber. This allows the use of special cryostats. This hole can be plugged so that the sample chamber 
can be used as normal with the standard set of sample holders. For this sample chamber option a standalone 
spectrometer controller is provided. 

A second special version of the sample chamber has an enlarged beam access port. This is needed to mount a 
vacuum UV refocusing flange for spectroscopy with VUV excitation. 

See the FLSP920 Series Reference Guide for details on sample chamber options. 

 

Accessing the Optical Compartments Inside the Sample Chamber 
Usually there is no need to access the optical components inside the large hexagonal sample chamber. However 
you may sometimes want to rearrange components for special experiments. To do this: 

Remove the round lid, front hatch and filter holder. 

Unscrew the four screws on the top of the large sample chamber cover plate. 

Remove the cable with the 9-way “D”-type connector in the sample chamber (on the left side behind the front 
sample chamber hatch). 

You can now carefully lift up the large cover plate. 

 

2.3.1. Standard Lens Optics 

The standard sample chamber has lens optics for focussing the excitation light onto the sample and collection of 
the emission light (see Figure 2-14). The lens assembly has two plano-convex fused silica lenses. In normal 
operation the lens surface facing the sample is 70mm away from the centre of the sample position. The 
demagnification of the lens assemblies is 2.3. A typical slit opening of the excitation monochromator of 0.55mm 
(~1nm band pass for a standard grating) would produce a 0.24mm wide beam at the sample position. The typical 
height of the excitation spot is 3-4mm. 

The lenses in the sample chamber are adjustable, although for standard applications re-adjustment should not be 
necessary. 

Before the lens assembly can be moved towards or further away from the sample, loosen the grub screw on top 
of the lens holder. You can then screw the lens assembly into or out of the mount. 
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2.3.2. Mirror Optics and Other Beam Steering Options 

Some applications require special beam focussing and beam steering options. These are available, refer to the 
FLSP920 Series Reference Guide for more details.  

The table below gives a summary of those applications. Note that the listed applications also require other options 
and accessories (beyond the mirrors or prisms in the sample chamber), such as lamps, lasers, special detectors. 

Application Suitable Optics where ? 

VUV excitation (<200nm) beam re-focussing vacuum flange excitation 

use of external lasers for sample 
excitation (not EPL and EPLED) 

beam steering prism excitation 

NIR detection (>1700nm) mirror optics or lens optics with special lens 
material 

emission 

NIR detection (>2500nm) mirror optics emission 

opaque samples in front face 
geometry 

mirror optics excitation and emission 

 

 

 

2.4. Sample Holders 
There are various different types of sample holder. All sample holders are “plug compatible” and have a common 
socket interface. Their cylindrical bases fit into a slotted doughnut-shaped socket piece located in the centre of 
the sample chamber.  A pointed tip knurled thumb screw on the base of each sample holder provides guidance 
for positioning and a way to fix the sample holder securely in place. 

 

2.4.1. Standard Single Cuvette Holder 

The standard sample holder is a single cuvette holder as shown below. 

                                           

Figure 2-15: Single Cuvette Sample Holder with Lens Assembly, Light Cones and Filters 
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This holder is suitable for liquid samples measured in the spectrometer’s standard right angle geometry. The 
sample holder has a socket for quick exchange with other optional sample holders, a thermally isolated base, a 
sample holder body with feed-through pipes for liquid cooling and a temperature sensor. A spring loaded roller 
ensures exact positioning of the sample and avoids scratching of the cuvette. The socket of the sample holder is 
mounted to the base by four M3 screws recessed in slotted holes, providing some freedom for adjustment along 
the optical axis of excitation. The socket also has slots to hold filters. 

The sample holder assembly is released by loosening the knurled knob on the bottom. The sample holder can be  
rotated and secured in multiples of 45 degrees. 

This sample holder can be “hot-swapped” (in other words, it can be removed and replaced at any time without 
switching off the spectrometer). The cable for the temperature sensor (terminated with a D-type connector) can be 
removed and refitted to the upper of the two D-type sockets next to the emission channel lens assembly. 

To completely remove the sample holder from the instrument, disconnect the coolant tubes (quick release 
fittings), the 9-way connector and – if present – the magnetic stirrer. For a temporary repositioning, simply move 
the sample holder to the right side inside the sample chamber. 

 

2.4.2. Other Sample Holders and Sample Positioning Options 

Other sample holders include 3-position sample turrets, front-facing sample holders for liquids, powders and films, 
holders with magnetic stirrers and a variety of sample cooling and heating options. Additionally, the sample 
chamber can accept an integrating sphere, adapters for multi-well plate readers, stopped flow assemblies 
titrators, computer-controlled sample positioners and fibre accessories. For details on these and other options, 
refer to the FLSP920 Series Reference Guide. 
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2.5. Detectors 
The  FLSP920 Series usually includes a high-gain photomultiplier (PMT) detector, suitable for photon counting in 
both steady state and time-resolved applications. 

Photomultipliers operating in photon-counting mode provide the highest sensitivity in the spectral range from 
200nm to 1700nm; for measurements above around 1700nm analogue detectors are required. 

A variety of photo-detectors can be fitted to the FLSP920 Series. When comparing detectors for sensitivity, two 
factors need to be considered: 

 Detector Responsivity, usually published by the detector manufacturers as spectral responsivity of 
quantum yield curves 

 Detector Noise, determined by the background signal (dark count rate or dark current) 

For the sensitivity of the whole spectrometer (as opposed to that of the detector alone) it is important to consider 
other factors such as the efficiency of the monochromators (grating curves), efficiency of the optics, and power 
and brightness of the light sources in the spectral range of interest. 

For details on detectors, alone and in combination with other spectrometer components, refer to the FLSP920 
Series Reference Guide. 

2.5.1. Red Sensitive Photomultiplier in Cooled Housing 

The standard photomultiplier is a side window photomultiplier with a spectral coverage from 200nm to ~870nm 
(Hamamatsu, R928P). This detector comes in a cooled housing that provides an operation temperature for the 
detector of -20oC to reduce the dark count rate to a minimum. 

The cooled housing comprises the optics for re-focussing the radiation from the exit of the monochromator to the 
photoactive area of the detector, the dynode chain socket, thermo-electrical cooling elements and a fan for heat 
dissipation. A separate power supply, CO1, provides power and controlling circuits for the cooling elements of the 
detector head. 

The detector bias voltage is supplied by the spectrometer controller. This is typically -1200V. 

 

                               

Figure 2-16: Detector assembly, comprising cooled head and power supply 

 

 

CAUTION! 

Do not disconnect the CO1 power supply from the detector when is use, as this can 
permanently damage the thermo-electrical circuit. 
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Detector Specification 
The spectral response of this detector is specified to extend to 870nm. At that wavelength the quantum efficiency 
is reduced about 300 times compared to the maximum at 300nm. 

The dark count rate at the operating temperature of -20 oC is typically 100cps.  

The detector’s minimum response width for time-resolved (TCSPC) measurements is 600ps. This is the 
characteristic width of the detector only. Additional contributions for broadening the temporal profile (such as the 
pulse width of the exciting light source) may also have an effect on the measured pulse width. 
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Figure 2-17: Quantum Efficiency of Red-Sensitive Photomultiplier 

 

2.5.2. Other Detectors 

Other detectors include extended-range red detectors, microchannel plate photomultipliers (MCP-PMTs), thermo-
electrically cooled InGaAs detectors, and liquid nitrogen cooled infrared detectors. For details on these, refer to 
the FLSP920 Series Reference Guide. 
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3. Introduction to F900 Software 
The F900 software application controls the FLSP920 Series of Fluorescence Spectrometers. Use it to set up 
measurement modes and parameters, configure spectrometer components, run scans and display and 
manipulate scan results. You can also import and export scan data to a variety of other standard applications. 

The following sections give an introduction to F900. For more details, refer to the F900 Online Help (Help > Help 
Topics) and the FLSP920 Series Reference Guide. 

 

3.1. Starting F900 
To start F900, double-click the F900 icon on your desktop or select Start > Programs > Edinburgh 
Instruments > F900 > F900. 

The F900 splash screen is displayed while the software initialises spectrometer components. This 
auto-calibration takes a minute or so, depending on how many computer-controlled components are 
connected to the spectrometer. 

Once initialisation is complete, the F900 main window is displayed with an open Signal Rate window (see Section 
3.3 Signal Rate Window on page 29). 

 

3.2. General Features of the F900 Main Window 
The F900 Main Window has three areas: a large Display Area for measurement results, a Tool Bar on the top of 
the screen and a Status Bar on the bottom, see Figure 3-1 for example. 

      

Figure 3-1: F900 main software window 
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Tool Bar 
The tool bar has a row of icons for commonly-used commands. Some icons will be greyed-out, depending on the 
currently selected display area window. 

 Scan Icons 

   
 

Opens the Signal Rate, New Spectral Measurement, or New Lifetime Measurement windows. See the following 
sections for details. 

 

 File Icons 

     
       

Open, save, import, export or print files. 

 

 Scan View Icons 

     
       

Change the view style for data windows. Depending on the type of a selected scan, switch the plot between 2D, 
3D, text, or contour plot. You can also set plot options such as axes fonts and units, screen colours, and labels. 

 

 Measurement Plot Icons 

       
     

Zoom in to or out of a plot or show the cursor so that you can select and get data on a specific area. Other icons 
enable a plot grid, view plot peaks, normalise the graphs (in a contour plot) and view or edit plot properties. 

 

 Measurement Container Icons 

   
         

Join scans into a single measurement container (multiple scans), split multiple scans or extract individual scans 
from measurement containers. 

 

 Scale Icons 

  
          

View the Y-axis in logarithmic or linear format. 
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Scan Display Area 
The Scan Display Area is where F900 scans and windows are displayed. You can have multiple scans open at 
the same time: use the Window menu to manage how they are displayed. 

Right-click on a scan to display a pop-up menu. From here you can view the scan’s properties, change the view 
and set multiple scan options. 

Status Bar 
The Status Bar at the bottom displays information about the current scan and spectrometer settings. What is 
displayed varies depending on whether a scan is in progress and on your particular component configuration. 

Both Tool Bar and Status Bar can be disabled using the View menu options. 

 

3.3. Signal Rate Window 
The Signal Rate Window (Setup > Signal Rate) is where you setup the wavelength and other parameters before 
starting a scan. It is displayed automatically whenever you start F900. 

                                                   

Figure 3-2: Signal Rate Window – principle layout 

Property Description 

Excitation Wavelength Set the excitation wavelength, step size* and spectral bandwidth. 

Emission Wavelength Set the emission wavelength, step size* and spectral bandwidth. 

Iris Setting Optically attenuate the light incident to the sample. 

Ex Polariser Enable the excitation polariser (if present) and set the polarisation angle. 

Em Polariser Enable the emission polariser (if present) and set the polarisation angle. 

Source Select the light source to use for the excitation. 

Detector Select the detector to use. 

Display Ref Signal Enable the display of the reference signal. 

Signal Rates Displays the current signal rates in counts-per-second (cps). 
 

* The “Step Size” is not the step size that is used for spectral scanning. The step size that can be selected here only applies 
when the up and down arrow in the wavelength selection box are used. 

The Signal Rate Window may have additional options depending on your spectrometer’s geometry configuration, 
number of monochromators and type of sample holder. 
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3.4. Setup Menus 
The Setup menu contains options to set up computer-controlled light sources (nF920, μF920H), computer 
controlled sample holders (sample positioners, plate reader attachments, titrators, etc) and sample cooling 
options (temperature controlled sample holders, cryostats). Computer controlled sample holders and 
cooling/heating devices are optional spectrometer accessories and are not covered by this user guide. Refer to 
the FLSP920 Series Reference Guide. 

This section only outlines the layout of the dialogue boxes for the nF920 nanosecond flashlamp and the μF920H 
microsecond flashlamp setup. Details on the Operation of these lamps are given in sections 5.3.1 and 5.2.1 on 
pages and 71 and 68, respectively. 

 

3.4.1. nF Lamp Setup 

Select Setup >> nF Lamp Setup to display the setup window for the nanosecond flashlamp. For details on the 
operation of the nF920 refer to section 5.3.1 on page 71. 

                                                     

Figure 3-3: nF920 lamp setup dialogue box 

 

Property Description 

Set Up Specify the lamp’s extra-high tension (EHT) and frequency, dependant on the 
filler gas and electrode gap size in use. 

Switch Lamp On/Off Click to switch the lamp on or off. By default, the lamp is started with Auto Start 
enabled. This ramps up the frequency during start-up. 

Measured Parameters Monitors the EHT, the lamp requency, and the gas pressure in the lamp. 

Stored Parameters Specify the lamp’s coolant gas and electrode gap size. These parameters have 
no impact on the operation, they are here for records that will appear in the 
properties of a measurement 
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3.4.2. μF Lamp Setup 

Select Setup >> μF Lamp Setup to display the setup window for the microsecond flashlamp. For details on the 
operation of the μF920H refer to section 5.2.1 on page 68. 

                                                               

Figure 3-4: μF900H lamp setup dialogue box 

Property Description 

Lamp Frequency Set the lamp’s frequency from 0.1 to 100 Hz. 

Detector Gating Enable gating (where applicable) to set the trigger delay and gate width. 
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3.5. Scan Types and Scan Properties 
The F900 software produces two different file types, annotated with the file extensions .FS and .FL, respectively, 
depending on whether the x-axis is wavelength or time.  

Each of these file types contains one or more measurement data or analysed data. These are called Scans. A 
variety of different scan plots are available and can be grouped into either spectral scan plots or time resolved 
scan plots. A file type may only contain scans of the same group of scan types, i.e. spectral data or time resolved 
data. 

This section of the manual briefly describes the scan plot types and outlines the scan properties that are attached 
to each scan. The scan properties are available via File >> Properties, or by right mouse click on the active data 
window and selection of Properties. If the active window contains more than one scan a property container is 
displayed first and a scan must be selected from the list of scans to view the scan properties. 

 

3.5.1. Spectral Data 

Excitation Scans 
Spectral scans, measured with fixed emission wavelength and scanning excitation wavelength. 

                   

Figure 3-5: Excitation Scan, typical display and scan properties 
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Emission Scans 
Spectral scans, measured with fixed excitation wavelength and scanning emission wavelength. 

              

Figure 3-6: Emission Scan, typical display and scan properties 

 

Synchronous Scans 
Spectral scans, measured with excitation and emission monochromators scanning simultaneously, using a fixed 
offset between excitation and emission wavelengths.  

 

Figure 3-7: Synchronous scan, typical display and scan properties 
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Excitation Correction Scans 
Spectral measurement of the reference detector (inside the sample chamber): This measurement records the 
spectral output of the excitation beam path and is therefore used to spectrally correct uncorrected excitation 
scans. The step size is typically 1nm and the scan is normalised to 1. Note that only Excitation Correction Scans 
can be used for spectral correction of Excitation Scans. Conversion of normal Excitation Scans into Excitation 
Correction Scans (using the file property dialogue box) is not possible. 

                  

Figure 3-8: Excitation Correction Scan, typical display and scan properties 

Emission Correction Scans 
Spectral measurement of the emission beam path: This scan contains the spectral information of the emission 
monochromator and the detector using calibrated light source(s) and is therefore used to spectrally correct 
uncorrected emission scans. The step size is typically 1nm and the scan is normalised to 1. Note that only 
Emission Correction Scans can be used for spectral correction of emission scan data. Conversion of normal 
Emission Scans into Emission Correction Scans is not possible. 

                  

Figure 3-9: Example of an Emission Correction Scan, typical display and scan properties 
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Excitation Anisotropy Scans 
Scans that result from automatically or manually acquired polarised excitation scans: The polarised excitation 
scans are used to calculate the Excitation Anisotropy function. An example is shown in Figure 3-10. 

                 

Figure 3-10: Excitation Anisotropy, typical display and scan properties 

 

Emission Anisotropy Scans 
Scans that result from automatically or manually acquired polarised emission scans. The polarised emission 
scans are used to calculate the Emission Anisotropy function. An example is shown in Figure 3-11. The plot in 
Figure 3-11 also contains the G-factor curve. 

                

Figure 3-11: Emission Anisotropy, display of anisotropy function (black) and G-factor curve (red), scan properties 
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3.5.2. Time-Resolved Data 

Time resolved measurements are data that were acquired by either TCSPC, MCS, Oscilloscope or standard 
single photon counting (kinetic scan). This scan type is sub-divided into decay measurements and measurements 
of the instrumental response function (IRF). If the measurement is an IRF then the box “Is Instrument Response” 
must be ticked (refer to the property box, bottom left: Is Instrument Response). Windows containing a single 
decay measurement can be analysed using Exponential Tail Fit analysis; windows containing a single decay 
and a IRF can be analysed using Exponential Reconvolution Fit analysis. 

Time Scan 

                  

Figure 3-12: Time Scan, typical display and scan properties 

Fitted Time Scans and Residual Time Scans 
The result of a numerical fit is a set of lifetime parameters, as well as two different types of Time Scans: The fitted 
function and the residual function. These time scans are typically not shown separately (although they can be) but 
together with the (raw data) IRF and decay.  

The properties of the Fitted Time Scan reveal the fit parameters. The properties of the Residual Time Scan 
present additional information, such as the Durbin Watson parameter. 
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Figure 3-13: Fitted Time Scans and Residual Scans, typical display and scan properties 

There are additional time scan types, e.g. Anisotropy Time Scans and Autocorrelation Time Scans. These 
types are similar to the Time Scan types outlined above and can be shown in the same graphical format with 
similar scan property boxes. Anisotropy Time Scans require the optional polarisers. 

 

3.6. Graphical Presentations and Plot Options 
F900 provides 2D graphics, 3D graphics, and contour plots for data visualisation, as well as a display of the 
numerical values for viewing and editing purposes. 

2D, 3D, and contour graphics have their own colour, font style and line style sets. These can be set up via the 
Plot Options. The three styles are used for the display of data within the F900 and when the graph is copied into 
the clipboard for further use in different computer applications (Ctrl + C). For 2D graphics, a separate set of 
colours and line styles may be set up for printing purposes (File >> Print). 

 

3.6.1. 2D Data Presentation 

Nine different 2D profiles can be independently set up in respect to their labels on X- and Y- axes, whether the Y-
axis should be scaled from Zero or not and whether the Y-axis is displayed in linear or logarithmic scale as 
default. The use of different 2D profiles eases the handling of different data types. For example, 2D graphics for 
spectral scans and kinetic data may be set up with linear Y-axis as default, whereas time resolved data and plots 
of fitted decay curves are with a logarithmic Y-axis. 

The nine different 2D plot defaults can be set up via Options >> Plot defaults >> 2D. The plot of each individual 
2D graph may also be changed right mouse click >> Plot options. 

Figure Figure 3-15 and Figure 3-16 below show typical 2D displays for illustration, a “Spectral” 2D plot and a “Fit 
Plot”, respectively. 

 

 

010

110

210

310

410

0 20 40 60 80 100 120 140 160 180

5.1

0.0

-5.1

C
ou

nt
s

R
es

id
ua

ls

Time/ns



FLSP920 Series User Guide 

 

38                                                     Edinburgh Instruments Ltd 

 

Figure 3-14: Setup of default 2D plot options 

 

 

Figure 3-15: Example for 2D display of spectral data 

 

 

Figure 3-16: Example for 2D display of time resolved data 
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Task Operation 

Set up 2D defaults Options >> Plot defaults >> 2D... 

Modify colours and line styles Plot options >> General,  

Modify axes labels, scaling 
from Zero, swap between 
wavelength/time and channels 

Plot options >> graph type tab  

Switch between linear and 
logarithmic Y-scale use  and  from the tool bar 

Switch cursor on or off View >> Show cursor, or . By setting the curser the X- and Y- values will 
also be displayed. 

Switch grid on or off View >> Show grid, or  

Show maxima, minima, or both View >> Show peaks, or .  Only available for spectral data. 

Modify the sensitivity of the 
peak search 

View >> Peak settings... Use this dialogue box also to specify, whether you 
want to display peaks, troughs, or both. 

Zoom use View >> Zoom In / Zoom Out or  /  

 

 

3.6.2. 3D Data Presentation 

Data display in 3D is available if multiple scans or scan maps are contained in the same active window. 

 

Figure 3-17: Example of a 3D display 
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Task Operation 

Set up 3D defaults Options >> Plot defaults >> 3D... 

Change colours Plot options >> Appearance  

Change the kind of mesh Plot options >> Mesh 

Zoom on X, Y, and Z axes Plot options >> Zoom 

Rotate 3D display left mouse click and drag 

 

3.6.3. Contour Plots 

The contour plot option is available, if the active display contains more than one spectral scan or time resolved 
measurement. 

 

Figure 3-18: Example for Contour plot of spectral data 

 

Figure 3-19: Example for Contour Plot of time resolved data 
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Task Operation 

Set up 3D defaults Options >> Plot defaults >> Contour... 

Change colours, add/remove 
contour lines, make contour 
lines invisible 

Plot options  

Change resolution on time axis Plot options 

Zoom use View >> Zoom In / Zoom Out or  /  

Show live cross-hair and axes 
bars 

View >> Show cursor, or . X,Y and Z values are shown when cross hair 
is live. 

Freeze cross-hair and display 
in bars hold Ctrl and click left mouse click 

release fixed cross-hair hold Ctrl, then click left mouse click on cross-hair 

move cross-hair along one 
axis hold Shift 

Normalise data in display bars click  in tool bar 

 

 

3.6.4. View Numerical Data 

This facility enables you to view the numerical values of your scan. You can also edit individual data points. 

 

Figure 3-20: Display of numerical values of a scan 
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3.7. Data Operation and Analysis with F900 
F900 includes a suite of tools for operating and manipulating your data, accessed from the Data menu.  

The Data menu is displayed when the scan display area has at least one scan window open. Options available 
depend on whether the currently selected scan window contains spectral or lifetime measurements. 

 

Option Spectral 
Data 

Lifetime 
Data Description 

Combine   Combines data by adding, subtracting, multiplying, 
dividing, or (for spectral data) appending. 

Scale   Multiplies measurements by a specified factor. 

Normalise   Scales measurements to specified peak. 

Subtract Baseline   Subtracts a stationary background. 

Crop Range   Crop measurements down to a specified range. 

Smooth   Smoothes spectral data using a binomial technique. 

Differentiate   Differentiates spectral data using first, second, or 
higher order derivatives. 

Integrate   Integrates spectral data, from the shortest wavelength 
side to the longest. 

Correction   Apply manual spectral correction to existing scans. 

Reverse   Reverses data in a scan along the X-axis. 

Anisotropy Analysis   Recalculate lifetime anisotropy based on a suitable 
measurement container and a specified G Factor. 

Exp. Reconvolution Fit 
  

Reconvolutes a sample decay measurement based 
on an IRF, specified fitting range, and specified 
lifetime parameters. 

Exp. Tail Fit   Used to analyse scans containing a single decay 
measurement. 

Autocorrelation   Calculate an autocorrelation (residuals) curve. 

TRES Data Slicing   Slice TRES data based on a specified start time, stop 
time and number of slices. 

 

For more details, see Section 6, Data Operation, on page 85 and the FLSP920 Series Reference Guide. 
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3.8. Software and Hardware Options 
The F900 Options menu lets you configure various aspects of the software and spectrometer components. 

 

Option Description 

Correction Files Set the spectral correction files to be used for correction of spectral scans. See 
Section. 

Windows Options Set various options for what to do when opening, appending, or closing scan 
files. 

Measurement Options Set up whether to allow temperature map creation, and the temperature 
tolerance value for automatic map creation 

Analysis Options Enable background subtraction (lifetime data) and whether to enable integrating 
sphere and absorption calculations for spectral data.  

Plot Defaults Set plot and plot axis options for 2D, 3D, and contour plots.  

Sample Holder Options Select the type of sample holder to use. 

Select Plate Type Select, modify, or create new plate configurations when using a Well-Plate 
Reader for samples. 

Grating Change Change the monochromator gratings to match the detectors spectral range, or 
for optimising the spectral coverage.  

Oscilloscope Options Select whether a connected oscilloscope is active or inactive. 

PCS900 Configuration Set the signal thresholds for each channel on the PCS900 card. 

 

For more details se the FLSP920 Series Reference Guide,  
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4. Making Spectral Measurements 
FS920, FLS920, FSP920, and FLSP920 spectrometers can measure steady state photoluminescence spectra in 
the ultraviolet to near-infrared spectral range with single photon counting sensitivity. Other instruments of the 
FSLP920 series can measure spectra, too, but overall sensitivity/performance is somewhat reduced due to the 
lack of the appropriate excitation source. 

Typical scans are excitation or emission scans where the wavelength is the scanning parameter. Other possible 
scans are scans for producing correction files, maps, and multiple scans. The table below summarises the scan 
types available for a standard spectrometer. The table also includes spectral anisotropy scans, as polariser 
upgrades are popular, the acquisition of those spectral anisotropy measurements is included in this paragraph. 

Scan Type Scan Parameter Second (Map) Parameter 

Emission Scan emission wavelength excitation wavelength (fixed) 

Excitation Scan excitation wavelength emission wavelength (fixed) 

Synchronous Scan excitation and emission wavelengths, 
simultaneously 

excitation-emission offset (fixed) 

Excitation Correction Scans excitation wavelength n/a 

Emission Correction Scans emission wavelength n/a 

Excitation Anisotropy Scans excitation wavelength, measurement 
of vertical polarisation plane 
(horizontal polarisation plane optional 
for G-factor) 

emission wavelength (fixed), 
measurement of vertical and horizontal 
polarisation plane 

Emission Anisotropy Scans emission wavelength, measurement 
of vertical and horizontal polarisation 
plane 

excitation wavelength (fixed), 
measurement of vertical polarisation 
plane (horizontal polarisation plane 
optional for G-factor) 

Emission Map emission wavelength excitation wavelength, stepwise 
increased or decreased 

Synchronous Map excitation and emission wavelengths, 
simultaneously 

excitation-emission offset, stepwise 
increased 

Multiple Scans repeated excitation, emission, or synchronous scans with optional waiting time 
between repeats 

 
The recognition of optional sample holders and accessories by the F900 software will automatically increase the 
type of scans available. For instance, temperature maps will be possible if cryostats or Peltier cooled sample 
holders are detected, spatial (sample) maps will be possible with sample X-Y stages or well plate reader 
attachment, maps of concentrations will be available with the optional titrator, 

The operating instructions in this section assume that the instrument has been started, the spectrometer is in full 
operating conditions and samples have been prepared. If this is not the case, follow steps 1-5 below: 

1. Switch on the PH1 power supply, the spectrometer controller, cooler power supply, and the Xe900 
xenon lamp power supply. 

2. Switch on the computer. 

3. Double-click the F900 icon or select F900 from your Start menu to start the software. 

4. Wait for the software to finish its initialisation process and component calibration. Once complete, the 
Signal Rate window is displayed: 

5. Setup the sample for measurements. (This might include the use of special sample holders and 
mounts.) 
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The following sections will instruct how to perform the different types of spectral scans listed in the table above, 
using the F900 spectrometer operating software. The following rule applies to all spectral scans: 

Use the Signal Rate dialogue box  to prepare for a spectral scan, then use the scan type dialogue box (quick 

access via )  to set up or modify scan parameters and to start the scan. 

 
It is important to routinely use the Signal Rate dialogue box, as this contains some items that can only be setup 
there and not in any other spectral scan dialogue box. This applies to bandwidth settings, attenuator settings, 
polariser settings. 

                                                

Figure 4-1: Signal Rate window for setting up spectral measurements 

During spectral acquisitions the status bar on the button of the screen informs about the running activities, such 
as the number of the current scan, the sample temperature, the current monochromator settings, grating in use, 
spectral band width, angle of polarisation, etc. 

Active spectral scans can be aborted by either pushing the Esc button or by clicking the  tool button on the top 
right of the F900 screen. Note that the Esc button will only be active if the window containing the scan is in focus, 
not if a different data window has been highlighted. 

Details of the parameter settings of a completed scan can be viewed in the Spectral Scan Properties. The 
properties can be accessed via right mouse click >> Properties if the active window contains only one 
measurement or via right mouse click >> Properties >> Measurement List if more than one scan is present in 
the active data window. 

Section 4.8 on page 60 provides some best-practice advice on making measurements. 
 

4.1. Emission Scans 
Scans with a fixed excitation wavelength and variable emission wavelength are called Emission Scans. The 
emission scan range is typically at a longer wavelength than the fixed excitation. 

To set-up and perform an emission scan... 
1. Use the Signal Rate dialogue box to set up measurement parameters, i.e. excitation and emission 

wavelength for which the signal is expected to be at a maximum. Ensure that the correct source 
(typically the steady state lamp Xe900) and the right detector have been selected. The photon count 
rate can be controlled by means of the attenuator (values between 1 and 100 are possible, note that the 
scale is not linear) and by means of the spectral band width in both the excitation and the emission 
beam path. In particular for solid or film samples it is important that the impact of the sample positioning 
and orientation on the signal rate is to be checked at this point. 

2. Close the Signal Rate dialogue box and open the dialogue screen Emission Scan Setup…. 
Upon opening this dialogue box all scan parameters of the last emission scan will be shown as default, 
apart from those that have been changed in the Signal Rate dialogue since the last scan. Typically this 
might be the excitation wavelength and spectral band pass (to be confirmed checking the Excitation tap) 
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and the spectral band pass in the emission (to be verified checking the Emission tap) . The Emission 
Scan Parameters in the lower section of the dialogue box may be changed now. 

                                                

Figure 4-2: Emission Scan Setup dialogue box 

3. The tap General offers a variety of correction options for the spectral scan. The correction methods are 
described in detail in section 8 of this manual. For less experienced users it is recommended to start 
with the boxes Recording Ref. Data in the excitation and Em1 File ‘...’ in the emission being ticked. 
However, it is also strongly recommended that the user measures his sample fully uncorrected, so that 
the impact of the correction on the data can be studied. The tick-box Display Ref. Data is only present 
if this option has been chosen in Options >> Misc. Options. If this box is checked the data from the 
reference detector will be displayed in a separate window. This might be useful for subsequent 
correction. The function Subtract Background is switched on by default as soon as one of the 
automated correction methods has been selected. With the Background subtraction option being 
selected the background signal will be recorded prior to each scan and before each repeated scan. 

4. All emission scan parameters can be saved by checking the Apply button. This will not start the scan, 
but it saves the parameter settings should the user decide to close and re-open this dialogue box. By 
checking the Start button the demonstrated scan parameters will be saved, the dialogue box will close 
and the spectral scan will begin. 

The Emission Scan graph is displayed with points plotted in real-time. The auto-scaling Y-axis shows the number 
of photon counts for the total dwell time measured. Once the measurement is finished, you can right-click in the 
scan window to display a pop-up menu to change view settings and to view the scan properties. 

Monitor the scanning process from the status bar. This shows the actual excitation and emission wavelengths, the 
current scan repeat number, the number of counts of subsequent scans and other information. 

5. Select File >> Save to save the scan. 

 

4.2. Excitation Scans 
Scans where the emission wavelength is fixed and the excitation wavelength is scanned over a pre-defined range 
are known as Excitation Scans. 

The scan range is typically at shorter wavelength than the fixed emission. Excitation scans reveal the absorption 
properties of a sample. They are useful in particular for the investigation of sample mixtures, as by means of the 
fixed emission wavelength species can be selectively measured. 

To set-up and perform an emission scan... 
1. Use the Signal Rate dialogue box to set up measurement parameters, i.e. excitation and emission 

wavelength for which the signal is expected to be at a maximum. Ensure that the correct source 
(typically the steady state lamp Xe900) and the correct detector have been selected. The photon count 
rate can be controlled by means of the attenuator (values between 1 and 100 are possible, note that the 
scale is not linear) and by means of the spectral band width in both the excitation and the emission 
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beam path. In particular for solid or film samples it is important that the impact of the sample positioning 
and orientation on the signal rate is to be checked at this point. 

2. Close the Signal Rate dialogue box and open the dialogue screen Excitation Scan Setup…. 
Upon opening this dialogue box all scan parameters of the last excitation scan will be shown as default, 
apart from those that have been changed in the Signal Rate dialogue since the last excitation scan. 
Typically this might be the emission wavelength and spectral band pass (to be confirmed checking the 
Emission tap) and the spectral band pass in the excitation (to be verified by checking the Excitation 
tap) . The Excitation Scan Parameters in the lower section of the dialogue box may be changed now. 

                                                       

Figure 4-3: Excitation Scan Setup dialogue box 

3. The tap General offers a variety of correction options for the spectral scan. The correction methods are 
described in detail in section 8 of this manual. For less experienced users it is recommended to start 
with the box Recording Ref. Data being ticked. However, it is also strongly recommended that the user 
measures his sample uncorrected, to study the impact of the correction on the data. The tick-box 
Display Ref. Data is only present if this option has been chosen in Options >> Misc. Options. If this 
box is checked the data from the reference detector (corrected for the response of silicon) will be 
displayed in a separate window. This might be useful for subsequent correction. The function Subtract 
Background is switched on by default as soon as one of the automated correction methods has been 
selected. With the Background subtraction option being selected the background signal will be recorded 
prior to each scan and before each repeated scan and will then be subtracted from the raw scan data. 

4. All excitation scan parameters can be saved by checking the Apply button. This will not start the scan, 
but it saves the parameter settings should the user decide to close and re-open this dialogue box. By 
checking the Start button the demonstrated scan parameters will be saved, the dialogue box will close 
and the spectral scan will begin. 

4.3. Synchronous Scans 
With synchronous scans both the excitation and the emission wavelengths are scanned simultaneously, with the 
offset between excitation and emission being either Zero or with the emission wavelength at a fixed offset above 
the excitation wavelength.  

Synchronous scans are useful for the characterisation of complex fluorophore mixtures. For Zero-Offset 
synchronous scans, those species that have a non-zero overlap between the excitation and the emission 
spectrum will produce characteristic spectral bands. The width of the bands will depend on the width of the 
spectral overlap, while the amplitude of the bands is proportional to the absorbance and the fluorescence 
quantum yield of the species contained in the sample. For Non-Zero-Offset synchronous scans, species with shift 
between absorption and emission that is equal to the offset will produce the biggest signal. 

To set-up and perform a synchronous scan... 
1. Use the Signal Rate dialogue box to set up measurement parameters, i.e. excitation and emission 

wavelength for which the signal is expected to be at a maximum. Ensure that the correct source 
(typically the steady state lamp Xe900) and the correct detector have been selected. The photon count 
rate can be controlled by means of the attenuator (values between 1 and 100 are possible, note that the 
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scale is not linear) and by means of the spectral band width in both the excitation and the emission 
beam path. In particular for solid or film samples it is important that the impact of the sample positioning 
and orientation on the signal rate is to be checked at this point. 

2. It is important to note that synchronous scans with an offset of Zero are only meaningful for samples 
that have negligible scattering properties. If the sample scatters significantly an offset different from 
Zero should be chosen with the spectral band width of both excitation and emission smaller than the 
offset.  

3. Close the Signal Rate dialogue box and open the dialogue screen Synchronous Scan Setup.. 
Upon opening this dialogue box all scan parameters of the last synchronous scan will be shown as 
default. The Excitation Scan Parameters and the lower section and the Ex to Em offset in the Emission 
tap may be changed now. 

 

Figure 4-4:  Synchronous Scan setup dialogue box 

4. As for excitation and emission scans, the tap General offers a variety of correction options for this 
spectral scan. The correction methods are described in detail in section 8 of this manual. For less 
experienced users it is recommended to start with the boxes Recording Ref. Data in the excitation and 
EmCorr Scan in the emission being ticked. However, it is also strongly recommended that the user 
measures his sample fully uncorrected, so that the impact of the correction on the data can be studied. 
The tick-box Display Ref. Data is only present if this option has been chosen in Options > Misc. Options. 
If this box is checked the data from the reference detector will be displayed in a separate window. This 
might be useful for subsequent correction. 

5. All synchronous scan parameters can be saved by checking the Apply button. This will not start the 
scan, but it saves the parameter settings should the user decide to close and re-open this dialogue box. 
By checking the Start button the demonstrated scan parameters will be saved, the dialogue box will 
close and the spectral scan will begin. 

Note that for synchronous scans the parameter on the X-axis is the excitation wavelength. The offset of the 
emission is registered in the scan properties. 

 

4.4. Correction Scans 
Correction scans are spectral scans that are used to generate files suitable for spectral correction. The 
spectrometer comes supplied with a set of correction files, the number of these files is dependent on the number 
of gratings, light sources and detectors. For a standard spectrometer with one excitation source (Xe900), one 
detector (single photon counting PMT) and one grating (or grating set) for both excitation and emission 
monochromator, two correction files are required: an Excitation Correction File and an Emission Correction 
File. The Correction Scan option allows to measure spectra that can be converted into correction files. 

Correction scans are of a different file type than excitation, emission, or synchronous scans. Only correction 
scans can be converted into correction files that are then used for spectral correction. Correction files can be 
assigned for correction in Options >> Correction Files.  
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4.4.1. Excitation Correction Scans 

Excitation correction scans are measured using the calibrated reference detector. Excitation correction files are 
generated for each individual FLSP920 series spectrometer at the Edinburgh Instruments factory. The file is made 
with a fixed bandwidth (generally 1nm), therefore, strictly speaking the spectral correction provided is only valid 
when the same bandwidth is used to make the measurement. However the user is able to generate new 
correction files for the different bandwidths in use. A new correction file should also be generated if the Xe900 
bulb has be re-aligned, e.g. after lamp replacement. 

To set-up and perform an excitation correction scan... 
1. Use the Signal Rate dialogue box to observe the signal of the reference detector. Set up parameters of 

the excitation arm, e.g. excitation bandwidth. Ensure that the correct source (typically the steady state 
lamp Xe900) has been selected. Select a wavelength where the excitation is at a maximum (this is 
grating and bandpass dependant but is normally 468nm). The signal rate on the reference detector can 
be controlled by means of the attenuator (values between 1 and 100 are possible, note that the scale is 
not linear), the signal level should not exceed 4,000,000. 

2. Close the Signal Rate dialogue box and open the dialogue screen Correction Scan >> Excitation…. 
Upon opening this dialogue box all scan parameters of the last excitation scan will be shown as default, 
apart from those that have been changed in the Signal Rate dialogue since the last correction scan. The 
Correction Scan Parameters in the lower section of the dialogue box may be changed now. Typical 
scan parameters for a standard visible grating and Xe900 are shown in Figure 4-5.  

                                                   

Figure 4-5: Excitation Correction setup dialogue box 

3. Start the measurement (START). A typical scan result is shown in Figure 3-8. 

Generating the excitation correction file from the excitation correction scan is straight forward: As the reference 
detector is a corrected detector (the correction file for this detector is called Si Ref Corr.FS), no further file 
manipulation is required. For convenience the measurement may be normalised to Unity.  

The reference detector is corrected in units of photon flux (or spectral radiance in photon units). Therefore any 
corrected excitation scan will have the same units. 

To generate the Excitation Correction File from the Excitation Correction Scan ... 
4. Normalise the measurement for convenience. 

5. Save the file in an appropriate location, such as  
C:\DocumentsandSettings\AllUsers\ApplicationData\EdinburghInstruments\F900 (WindowsXP) or  
C:\ProgramData\Edinburgh Instruments\F900 (Windows 7) 

6. In order for the F900 software to use this file as an excitation correction file, the file needs to be 
assigned as such. To do this go to Options > Correction files, select the excitation tab and select 
‘modify’ to allocate the newly saved file.  
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4.4.2. Emission Correction Scans 

A calibrated light source of known spectral output is needed to generate emission correction files. Emission 
correction files are made for each individual FLSP920 series spectrometer at the Edinburgh Instruments factory 
using calibrated deuterium and tungsten lamps. For detectors with sensitivity beyond 2.5μm a calibrated Nernst 
source is used. 

The calibrated light sources that are used to produce the Emission Correction File are calibrated in units of photon 
flux (or spectral radiance in photon units). Therefore any corrected emission scan will have the same units. 

The emission correction scans are made with a fixed bandwidth (generally 1nm). The bandwidth dependence is 
not nearly as critical as for excitation correction scans, as the detector responsivity has no narrow spectral 
features, compared to those of the xenon lamp.  Therefore the same emission correction file can be safely used 
for all spectral band widths. Re-calibration of the emission channel is only required when detectors or gratings are 
changed or replaced. An emission correction file produced once will last for years. Re-calibration is only be 
needed for the purpose of verification of the long term stability of the emission channel. 

You can re-calibrate the emission channel using your own calibrated lamps, you can purchase a calibration set 
from Edinburgh Instruments, or contact the company for a loan of the calibration set.  

A complete correction file for the spectral range between 200nm and 900nm is generated from four independent 
emission correction scans, as shown in the table below. This is necessary as the resulting correction file is 
supposed to be free of higher order artefacts caused by grating in the emission monochromator. Higher orders 
are blocked by the given short wavelength cut-off filter. 

Scan Number Calibrated Light Source Filter Scan Range 

1 Tungsten – 300nm – 420nm 

2 Tungsten 350nm 400nm – 620nm 

3 Tungsten 550nm 600nm – 900nm 

4 Deuterium –  200nm – 400nm 

To set-up and perform an emission correction scan... 
1. Install the tungsten calibration lamp and the scattering prism as described (refer to FLSP920 Series 

Reference Guide). 

2. Use the Signal Rate dialogue box to observe the detector signal. Set up emission parameters. Ensure 
that the correct detector has been selected. For more complex systems also check that the desired 
grating has been selected. Choose a wavelength where the emission is at a maximum (for a system 
with standard detector this is around 550nm). The signal rate can only be controlled by means of the iris 
that is part of the calibration lamp. The signal level should not exceed 2,000,000cps. 

3. Close the Signal Rate dialogue box and open the dialogue screen Correction Scan >> Emission…. 
The Correction Scan Parameters in the lower section of the dialogue box may be changed now. The 
scan parameters for the first scan are shown in Figure 4-6.  

4. Start the fist of the four correction scans (START). 

5. Make the remaining two correction scans. Note that these are measured with wavelength filters in place 
(filter holder in emission channel near scattering prism) and with different scan ranges. 

6. Now install the deuterium lamp, use the Signal Rate screen to optimise the signal for 400nm, then make 
than last spectral scan. 
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Figure 4-6: Emission Correction setup dialogue box 

To generate the Emission Correction File  ... 
7. Subtract the background level from each of the four scans. This procedure is not necessary if the 

detector has a negligible background or if the background subtraction had been done automatically 
during the scans. 

8. Overlay the tungsten measurements (scans 1-3 – Join Visible tool button) and verify a good match in 
the cross-over sections. The filters listed in the table above have a flat transmission in the given scan 
range, errors due to variation in the transmission in the stated scan range are negligible, although a 
scaling may be required. 

9. Join the three emission scans (Data >> Combine >> Append), using the short wavelength scan first. 
Ensure the Scaling option isa applied. The result of this procedure is one emission correction scan. 

10. Divide the remaining two correction scans (generated by deuterium and tungsten lamp) by the 
corresponding lamp file, i.e. the scans that was measured using the deuterium lamp by the deuterium 
file, the (joined) scan that was measured with the tungsten lamp by the tungsten file. 

11. Overlay the corrected deuterium measurement with the corrected tungsten measurement (Join Visible 
tool button) and verify a good match in the cross-over section. The files may have to be scaled for better 
visualisation. It is important to have a good match of the two files, typically in the range between 350nm 
and 380nm. 

12. Join the two emission correction files in the centre of the matching region, using the append function 
(Data >> Combine >> Append). The file may now be  

13. Normalise the measurement for convenience. It might also be appropriate to use the smooth function, 
provided spectral features will not be distorted. A typical emission correction file is shown in Figure 3-9. 

14. Save the file in an appropriate location, such as  
C:\DocumentsandSettings\AllUsers\ApplicationData\EdinburghInstruments\F900 (WindowsXP) or  
C:\ProgramData\Edinburgh Instruments\F900 (Windows 7) 

15. In order for the F900 software to use this file as an emission correction file, the file needs to be assigned 
as such. To do this go to Options > Correction files, select the emission tab and select ‘modify’ to 
allocate the newly saved file.  
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4.5. Spectral Anisotropy Scans 
The measurement of spectral fluorescence anisotropy requires computer-controlled polarisers in both the 
excitation and the emission channels (optional accessory for all FLSP920 spectrometers). Linearly polarised light 
of vertical (V = 00) and horizontal (H = 900) orientation are used to excite the sample and detect the sample 
emission. See the FLSP920 Series Reference Guide for more details on the FLSP920 polariser accessory. 

Anisotropy measurements reveal information about the ability of the average assembly of molecules to rotate 
during the short period of being in an excited state. For most fluorophores, anisotropy effects are only observed 
when the solvent has a high viscosity (e.g. glycerol and mineral oil) or when the fluorophores are attached to 
slowly rotating macromolecules (e.g. bound to proteins or embedded into membranes). In low viscosity solvents 
(such as water and ethanol) spectral anisotropy is generally not seen as the rotation effects are too fast. 

Before performing anisotropy measurements, measure the sample’s excitation and emission fluorescence spectra 
without polarisers. This way you can familiarise yourself with the sample’s range of maximum absorption and 
emission. 

Before you can start making the polarised measurements you must move the polarisers into the beam path. For 
this open the sample chamber lid and locate the handles for the polarisers (Figure 4-7). Then open the Signal 
Rate dialogue box and tick the box Ex Polariser. A message will come up that asks you to move the excitation 
polariser into the beam (Figure 4-8). Do so by moving the leaver into the “IN” position (Figure 4-7), then quit the 
message with Retry.  Repeat the same procedure with the emission polariser. 

The spectrometer is now ready for the anisotropy scans. 

                                       

 Figure 4-7: Polariser assembly 

 

                                               

Figure 4-8: Signal Rate box with active polarisers 
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4.5.1. Excitation Anisotropy Scans 

Excitation anisotropy functions are calculated from either four linear polarised excitation scan measurements (IVV, 
IVH, IHV, IHH) or from two measurements  (IVV and IVH), depending on whether G-factor correction is applied or not. 
The equations for the calculation of the G-factor, the anisotropy free excitation scan, and the anisotropy function 
are given in the formula section on page 103, equations (1) – (3). 

To setup and perform and Excitation Anisotropy Scans... 
1. Use the Signal Rate dialogue box to set up measurement parameters, i.e. excitation and emission 

wavelengths for which the signal is expected to be at a maximum. Ensure that the correct source 
(steady state lamp Xe900) and the right detector have been selected.  

2. With all other settings remaining unchanged, check the signal levels for all four combinations of 
polariser orientations: Excitation polariser = 0o and 90o, Emission polariser = 0o and 90o. Ensure that 
none of the signals exceeds 2 million cps. Adjust the monochromator slits and the attenuator 
accordingly. 

3. Close the Signal Rate dialogue box and open Anisotropy Scan >> Excitation. Enter appropriate scan 
parameters in the lower section of the dialogue box, then select the Anisotropy tab (Figure 4-9) to define 
the anisotropy specific settings. 

                                                

Figure 4-9: Excitation Anisotropy Setup Dialogue Box 

4. The Anisotropy tap contains options for the G-factor corrections. Typically the G-factor correction is 
checked and Measure at peak is selected. With this option the two scans IVV  and IVH will be measured. 
At the end of the two scans the software will move the excitation monochromator to the peak of the IVV 
scan and will then set the excitation polariser to the horizontal position to measure IHH and IHV at this 
peak wavelength. Alternatively, if the G-factor is known the Use value can be selected and the known 
G-factor can be manually entered. A typical example for the set of polarised fluorescence excitation 
scans is given in Figure 4-10. Note that these curves are spectrally uncorrected. For the calculation of 
the fluorescence anisotropy functions correction of the individual polarised curves is not required. 
However, it is important to note that a possible detector background should be automatically subtracted, 
as a significant background would impact on the resulting anisotropy function. 

5. At the end of the scans the G-factor will automatically be measured (if the option was selected - see 
above) and finally the excitation anisotropy scan will be generated in a separate data window. The G-
factor can be viewed in file properties of this measurement result (right mouse click >> Properties). 
Typical raw polarised measurements are shown in Figure 4-10 overleaf. A typical anisotropy scan and 
the corresponding scan properties are shown in Figure 3-10 on page 35. 
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Figure 4-10: Raw polarised fluorescence excitation scans of rhodamin B in glycerol: 

 

4.5.2. Emission Anisotropy Scans 

Emission anisotropy scans are similar to excitation anisotropy scans in the way the polarised measurements 
IVV(λ) and IVH(λ) are made. However, they are different in respect to the G-factor correction. While for the 
excitation anisotropy only one G-value is required (as the emission wavelength is fixed), a whole curve of G-
values is required for the correction of the emission anisotropy, i.e. each emission wavelength setting has a G-
factor. The equations for the calculation of the G-factor curve, the anisotropy free emission scan, and the 
emission anisotropy function are given in the formula section on page 103, equations (4) – (6). 

For single species, emission anisotropies are typically independent of the wavelength (as there is only one 
emission dipole involved) and provide therefore – compared to excitation anisotropy scans – only limited 
information. 

To setup and perform and Emission Anisotropy Scans... 
1. Use the Signal Rate dialogue box to set up measurement parameters, i.e. excitation and emission 

wavelengths for which the signal is expected to be at a maximum. Ensure that the correct source 
(steady state lamp Xe900) and the right detector have been selected.  

2. With all other settings remaining unchanged, check the signal levels for all four combinations of 
polariser orientations: Excitation polariser = 0o and 90o, Emission polariser = 0o and 90o. Ensure that 
none of the signals exceeds 2 million cps. Adjust the monochromator slits and the attenuator 
accordingly. 

                                                    

Figure 4-11: Emission Anisotropy setup dialogue box 

IVV(λexc) 

IVH(λexc) 
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3. Close the Signal Rate dialogue box and open Anisotropy Scan >> Emission. Enter appropriate scan 
parameters in the lower section of the dialogue box, then select the Anisotropy tab to define the 
anisotropy specific settings. 

4. The Anisotropy tab contains options for the G-factor corrections. On the top left of this dialogue tap you 
decide whether to measure a complete emission anisotropy scan (i.e. an anisotropy scan with G-factor 
correction) or to measure the G-factor curve only. Typically the (complete) Anisotropy Curve option will 
be selected and with this two options for the G-factor are given: If the first of the two G-factor options 
was selected (Also measuring G-factor Curve (HH/HV)) the full measurement will finally contain all 
four polarised curves, i.e. IVV(λ), IVH(λ), IHV(λ) and IHH(λ). If the second of the two G-factor options was 
selected only IVV(λ) and IVH(λ) will be measured and a previously measured G-factor curve can be 
loaded before the anisotropy calculation is performed. A typical example for the set of polarised 
fluorescence emission scans is given in Figure 4-12. 

5. After scanning both the G-factor curve and the emission anisotropy curve will be displayed in different 
windows. Figure 3-11 shows an example of both curves. 
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Figure 4-12: Raw polarised fluorescence emission scans of rhodamin 6G in glycerol 
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4.6. Emission Maps 
Emission Maps are a series of emission scans (see Section 4.1 on page 46) with excitation wavelengths being 
systematically changed. Emission maps are often displayed by means of a contour plot graphic; this view is often 
referred to as EEM (Excitation-Emission-Map) 

To set-up and perform an Emission Map measurement ... 
Have sufficient background knowledge about the sample’s emission properties. It is useful to perform one or more 
emission scans (refer to section 4.1 on page 46) with the aim to find the set of excitation and emission 
wavelengths at which the signal is at the maximum. 

1. Open the Signal Rate screen, enter the set of excitation and emission wavelength for the expected 
maximum signal. Then select the spectral band widths and the attenuator setting so that the detector 
signal is appropriate, i.e. < 2 million cps). It might be appropriate to choose identical band widths for 
both excitation and emission. 

2. Close the signal rate screen and open the Emission Map Setup dialogue box. 

3. Use the lower section of the dialogue box to enter the appropriate excitation range and emission range, 
select the step sizes, the dwell time and the number of scans. Remember that the map is generated by 
performing emission scans with sequential increase (or decrease) of the excitation wavelength. For 
equal resolution on the X- and the Y axes of a future contour plot it would be appropriate to select 
identical wavelength step sizes for both excitation and emission. The overall measurement might take a 
long time, so keep Dwell Time and Number of Scans to a minimum, the step sizes to an affordable 
maximum. 

4. Select the General tab and choose the method of spectral correction. 

 

Figure 4-13: Emission Map Setup – General 

5. Select the Excitation tab and decide whether the excitation should be stepwise increased – no tick, or 
stepwise decreased – tick the box Reverse Excitation Order (refer to Figure 4-14). Use the latter 
option when there is a risk for noticeable photo-degradation of the sample during the long measurement 
time. Starting at longer wavelengths (lower excitation energies) reduces the impact of photo-
degradation on the measurement. 
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Figure 4-14: Emission Map Setup – Excitation 

6. Select the Emission1 tab. If none of the boxes in this tab are ticked, the scanning will cover the full 
range as specified in the lower section of the dialogue box. However, this potentially means that the 
emission will scan across the excitation. (In the given example of Figure 4-15 this applies to the cross-
over section between 300nm and 500nm.) For scattering samples the cross-scanning is not desirable, 
in this case tick the upper of the two boxes. If you also want to avoid to pick up the second order scatter, 
tick the lower box, too. Once a box is ticked you have the option to decide, how many nanometers away 
from the actual excitation wavelength the emission scan should start. 

7. Start the scan: Start.  

 

Figure 4-15: Emission Map Setup – Emission 
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4.7. Synchronous Maps 
 

Synchronous Maps are a series of synchronous scans (see Section 4.3 on page 48) with the offset between 
excitation and emission being systematically increased.  

To set-up and perform a Synchronous Map measurement ... 
Gain sufficient background knowledge of the sample’s emission properties. It is useful to perform one or more 
synchronous scans (refer to section 4.3 on page 48) with the aim to find the set of excitation wavelength and 
emission offset for which the signal is at the maximum. 

                                              

Figure 4-16: Synchronous Map Setup - General 

 

1. Open the Signal Rate screen, enter the set of excitation and emission wavelength for the expected 
maximum signal. Then select the spectral band widths and the attenuator setting so that the detector 
signal is appropriate, i.e. < 2 million cps). It might be appropriate to choose identical band widths for 
both excitation and emission. 

2. Close the signal rate screen and open the Synchronous Map Setup dialogue box. 

3. Use the lower section of the dialogue box to enter the appropriate excitation range and the range for the 
emission offset, select the step sizes, the dwell time and the number of scans. Remember that the map 
is generated by performing synchronous scans with sequential increase of the emission offset. The 
overall measurement might take a long time, so keep Dwell Time and Number of Scans to a minimum, 
the step sizes to an affordable maximum. 

4. Select the General tab and choose the method of spectral correction. 

5. Start the map measurement: Start. 
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4.8. Tips for Making Good Spectral Measurements 
 

It is always useful to know your sample’s absorption properties before attempting spectral emission 
measurements. If proper spectroscopic data are not available, even just looking at the sample can provide 
valuable information. For example, samples that are transparent will most likely absorb in the UV, and are likely to 
emit (if indeed there is any emission) in the blue spectral range. Samples that have yellow colour will absorb in 
the 400nm region and will probably emit green or orange, samples that are blue will absorb at around 600-700nm 
and will have dark red or even infrared emission. 

You should also gain experience with sample concentration and alignment issues. Liquid samples are easier to 
measure than solid or film samples, as typically less scattering is involved and alignment effects are negligible. 
However, even with liquids concentration effects can seriously affect the quality of spectral scans. For samples 
with absorption and emission in the visible spectral range it is useful to physically observe the sample when it is 
excited: 

1. Open the sample chamber lid. This will close the detector shutter (for protection) and will allow you to 
observe the sample. 

2. Select the Signal Rate box. This will open the excitation shutter so that excitation light is permitted to 
the sample. 

3. Set the excitation wavelength to a value that is consistent with the sample’s main absorption. 

4. Look at the sample! Observe the excitation, distinguish between excitation and emission (a filter in front 
of the eye might help), gain an insight into potential problems with sample alignment and concentration. 

The following is a list of potential effects, problems and sources of errors, together with some tips on how to 
overcome or minimize them. 

 

Tips for all types of spectral scans: 
 

1. Inner Filter Effect 

 

When working with liquid samples, sample concentrations should be chosen that are small enough to avoid the 
inner filter effect. If the concentration is high, and a wavelength of excitation is selected that is in a range where 
the sample has high absorbance, only the cuvette surface facing the excitation beam is strongly emitting and no 
excitation light might reach the cuvette centre. However, the cuvette centre is imaged into the emission 
monochromator. Therefore not much light might reach the detector. 

It is instructive to study this effect by observing the situation using your eyes, for example using a highly 
concentrated sample of fluorescein with excitation at about 490nm. The emission can be observed with the 
sample chamber lid open and the signal rate dialogue box open (so that the excitation shutter is open). 

Tips: 

o Reduce the concentration of the fluorophore(s). 
o Chose an excitation wavelength that is in a range where the sample absorbance is reduced. (This can cause 

other problems, such as excitation of unwanted sample species or sample contaminations.) 
o Use micro-cuvettes or triangular cuvettes. 
o Use a front face sample holder, this allows to detect the emission at the same surface that also faces the 

excitation beam. 
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2. Higher Order Effect 

 

A large spike may appear at a wavelength that has the doubled value as that of the excitation wavelength. 

This is the second order of the excitation; the problem is a typical phenomenon of a grating monochromator. In 
this case the problem is generated in the emission monochromator which, when set to a specific wavelength, will 
not only transmit this selected wavelength, but also a wavelength with half (and third, and fourth…) of the 
numerical value. The problem also appears in the excitation monochromator, but there it is less frequently seen 
as the excitation wavelength is often shorter than the emission wavelength and often the second order is highly or 
even completely suppressed. 

Tips: 

o Use a wavelength cut-off filter (blocking at shorter, transmitting at longer wavelength) in the emission beam 
path (bind the sample). The filter’s cut-off wavelength should be a little shorter than the starting wavelength 
of the scan. 

o If a scan is to be performed over a wide range (say 300-800nm) one might even see the second order of the 
emission (in this case the emission from 300-400nm re-appearing between 600-800nm). In this situation 
there is no other way than measuring the emission spectrum in two steps, with two different cut-off filters, 
and subsequent joining (Data > Combine .> Append). 

 

 
3. Weak Sample Emission 

 

The sample shows very weak emission. What options are there to increase the signal? 

Tips: 

o The utmost important task is to check the positioning of the sample in the sample compartment. A visible 
inspection of the sample excitation is recommended (look at the sample when the Signal Rate screen is 
open). If the excitation is outside the visible spectrum it might be changed temporarily to 500nm for an 
assessment of the situation.  

o The sample volume of a liquid sample might be too low. Increase the volume, use a micro-cuvette, or raise 
the cuvette. 

o Bulk or film samples might have to be re-positioned. 
o Increase the spectral band pass. If this is only done in the excitation it is still possible to obtain good spectral 

resolution for the emission scan. In the worst case both spectral band passes in excitation and emission 
have to be increased. 

 
Please note: With very wide spectral band widths there is an increased risk to measure stray light that passes 
through the monochromators. There is also an increased risk to accidently over-expose the detector when 
scanning over the excitation or over the second order of the excitation. 

 

 
4. Detector Saturation 

 

If the detector is exposed to too much signal (either sample emission, or scattered excitation light), the 
spectrometer will be unable to “count all photon” that impact on the detector. Although this saturation effect is 
usually caused by more than one problem, the common term is “detector saturation”. 

If detector saturation occurs it will not necessarily harm the detector, but surely the data are distorted. It therefore 
is good practice to stay out of the range of detector saturation. 

[The biggest cause for “detector saturation” is the randomness of the arrival times of photons at the detector and 
the subsequent randomness of the electrical pulses produced by the detector. A 100MHz counter would be able 
to count 100 million photon pulses that are all equi-spaced in time, but with random arrival times the narrow 
spaced pulses will be missed and therefore less than 100 million will be recorded.] 
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Detector saturation is easily overlooked when measuring with short dwell times. For example, a spectral scan that 
was acquired with a dwell time of 0.01s will be affected by saturation although the biggest signal is only 20,000 
counts. Remember the typical saturation threshold is at 2 million counts per second! 

Tips: 

o Use the Signal Rate screen prior to measurements to check for the maximum possible signal 
o Start with narrow spectral band widths before attempting bigger band widths. 
o Use the iris attenuator, if appropriate 
o Gain experience upper signal limits on scans with different dwell times. 
 
 
 

5. Repeat Scanning 

 

The dwell time, multiplied by the number of scans, results in the overall integration time per step (when the scan 
has finished). Is it better to use longer dwell times or a higher number of scans to improve the signal-to-noise 
ratio? 

Tip: 

o Use a shorter dwell time, (e.g. 0.1s or 0.2s) and instead a higher number of scans. This has the advantage 
that the overall spectrum is revealed at a fraction of the overall measurement time. An unwanted spectrum 
can therefore be aborted much earlier. Also, slow lamp fluctuations or potential detector background drift will 
be less significant in the measurement result as a result of multi-scan averaging. It is obvious that setting the 
dwell time to very short values has it’s limitations. This applies in particular to analogue detectors with build-
in Lock-in and the measurement of samples with very narrow spectral features. In those cases the dwell time 
should not be shorter than 0.3s.  

 

 

6. Spectral Correction 

 

Which type of spectral correction is best? Automated or manual? Which type of automated? 

There is no general answer to those questions, it often depends how demanding the specific task is. However, in 
the majority of applications the full automated correction as described in the sections above is appropriate. 
Nevertheless, it is unavoidable to study the correction and check out the various options. 

Tip: 

o Do fully uncorrected measurements and use the manual correction (Data >> Correction) to correct your 
data. 

o Study the impact of the background (high background, small signal levels). 
o Data that are measured in spectral regions of reduced detector sensitivity are significantly modified (in a 

positive and negative sense) by the correction. Spectral correction in this spectral region is particularly 
demanding. 

 
 

7. Samples with strong Absorption-Emission overlap 

 

With many samples the emission spectrum overlaps the excitation spectrum to some degree.  

Tip: 

o In order to measure the full emission spectrum it might be appropriate to excite the sample not at the peak of 
the absorbance, but some 10nm to 50nm before the peak. This increases the range over which the emission 
can be scanned without distortions by scattered light. 
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Tips specific for spectral anisotropy scans: 
 

8. Precision of G-factor 

 

A correct G-factor is essential for a good anisotropy measurement.  
 
Tips: 
o Generally, a precision of the G-factor to 2 decimal place is required. 
o For excitation anisotropies (where only one G-value is needed) the G-factor can be viewed and edited by 

selecting the window containing the original polarised scans and then selecting Data > Anisotropy (Ex). 
o Modifying the G-factor manually allows to assess the impact of the G-factor on the final anisotropy curve. A 

G-factor that is too small will shift the anisotropy towards negative values, a G-factor that is too big will result 
in an anisotropy that is too positive. 

o An unambiguous test for the correctness of the G-factor is to use a sample where the fluorophores are in a 
low viscous environment (e.g. water, ethanol). For those samples the anisotropy is expected to be Zero (the 
data are randomly distributed around Zero). If the G-factor is wrong the anisotropy curve will be offset from 
Zero. 

 

9. Impact of background on anisotropy function 

 

A high background in the scans of the raw polarised data will impair the anisotropy result, in particular in those 
regions where the sample signal is small.  
 
Tips: 
o Use the automated background subtraction. 
o If possible, increase the sample signal (still avoiding saturation for each of the polarised scans). 
 

10. Noise of anisotropy curves 

 

Anisotropy curves will always look more noisy than the original polarised scans. This is in particular true for those 
regions where the emission or excitation scans are of low amplitude.  
 
Tips: 
o Measure spectral fluorescence anisotropy curves only in those regions where the signal is significant. 
o The signal-to-noise ratio of anisotropy scans can be improved by increasing the signal and by increasing the 

number of scan repetitions and longer dwell times. When the signal is increased pay attention to avoid 
saturation of each of the polarised scans. 

 

11. Manual measurements of spectral anisotropy 

 

Anisotropy measurements can also performed manually, either by setting the polarisers to 00 and 900 in the signal 
rate screen and then making “normal” excitation or emission scans, or by even using non-standard polarisers 
such as dichroic sheet polarisers and then performing “normal” scans with the polarisers in the correct orientation.  
 
Tips: 
o If manual anisotropy measurements are made using the standard computer controlled polarisers, the 

polarisation angle is registered by the software and as long as at least the IVV and the IVH scans are 
contained in the same data window the anisotropy can be calculated using Data > Anisotropy. 

o If polarisers are used that are not recognised by the software, the polariser orientation can be edited 
manually in the properties of the measurement. Access the file properties (right mouse click on the graph) 
and select Properties. On the bottom right side of the scan properties tick the button Edit Values, then 
change the polarisation angle from none to either 0 or 90. Once the polarisation angle is edited and provided 
the active window contains at least IVV and the IVH, the anisotropy can be calculated using Data > 
Anisotropy. 
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5. Making Time Resolved Measurements 
All spectrometers of the FLSP920 series can acquire time resolved data, with different time resolution. The time 
resolution depends on whether the spectrometer can perform standard Single Photon Counting (SPC), Multi-
Channel Scaling (MCS) or Time Correlated Single Photon Counting TSCPC). All three techniques are single 
photon counting techniques. This guarantees highest detector sensitivity for all time ranges relevant for 
photoluminescence phenomena. Combined spectrometers (i.e. FLS920, FLP920, FSP920, and FLSP920) use 
more than one of the above techniques and therefore have and increased range of time resolution. You can find 
out which of the techniques is applicable to your spectrometer by studying section 1.1 FLSP920 Series Models on 
page 5.  

F900 automatically selects one of three techniques to acquire time resolved measurements. Which of the 
techniques is in use depends on the type of light source that has been selected.  

Time Range 
Technique 

pico nano micro mili sec min hour 

Standard Single Photon Counting (SPC)        

Multi-Channel Scaling (MCS)        

Time-Correlated Single Photon Counting (TCSPC)        

 

[FLSP920 spectrometers can also be upgraded to lifetime data acquisition by means of an oscilloscope (for 
performing time resolved measurements with analogue detectors in the near infrared spectral region). This fourth 
data acquisition method is optional, refer to the FLSP920 Series Reference Guide for details.] 

 

Standard Photon Counting for Kinetic Scans (Milliseconds – Hours) 
Kinetic Scans refer to measurements with a fixed excitation and a fixed emission wavelength, while the signal, in 
photon counts per unit time, is recorded over a time period of typically seconds to hours. Data acquisition is made 
using the PCS900 card in the computer. 

Throughout the measurement the sample excitation may be continuously on, for instance in the study of photo-
degradation, or the sample excitation may be on for a selected period of time, for instance in the study of after-
glow processes or for the study of both rise and decay kinetics. 

The “Kinetic Scan” option is available for all type of instruments of the FLSP920 series. The typical excitation 
source is the Xe900. 

 

MCS (Microseconds – Seconds) 
Multi-Channel Scaling (MCS) is a single photon counting technique that is used for recording luminescence 
decays in the time range between microseconds and seconds. A pulsed light source with low repetition rate is 
used to excite the sample and the photons emitted by the sample are recorded using the PCS900 card in the 
computer. 

Standard FLSP920, FP920, FLP920 and FSP920 spectrometers use the microsecond xenon flashlamp (μF900H) 
as light source for multi-channel scaling experiments. This lamp has a pulse width of <2μs and a pulse repetition 
rate between 0.1Hz and 100Hz.  

For a more detailed description of the MCS technique and alternative excitations sources refer to the FLSP920 
Series Reference Guide. 
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TCSPC (Picoseconds – Microseconds) 
Time-Correlated Single Photon Counting (TCSPC) is a single photon counting technique that is used for recording 
fluorescence data in the time range from picoseconds to microseconds. A high repletion pulsed light source is 
used to excite the sample and the photons emitted by the sample are processed using the TCC900 card in the 
computer. 

Standard FLSP920, FL920, FLP920 and FLS920 spectrometers use the nanosecond flashlamp (nF920) as the 
default light source for TCSPC acquisitions. This lamp has a pulse width of <2ns and a pulse repetition rate of 
typically 40 kHz.  

Picosecond pulsed diode lasers and picosecond pulsed light emitting diodes (EPLs  and EPLEDs), mode locked 
lasers and supercontiuum lasers are also increasingly used as light sources for TCSPC measurements with the 
range of FLSP920 spectrometers. 

For a more detailed description of the TCSPC technique and alternative excitation sources refer to the FLSP920 
Series Reference Guide. 

 

The following measurement types are available: 

Measurement Type Technique Parameter Second (Map) Parameter 

Kinetic Scan SPC time (millisec. – hours)  

Time Resolved Measurement MCS time (microsec. – seconds)   

Time Resolved Measurement TCSPC time (picosec. – microsec.)   

MCS time (microsec. – seconds)   
Multiple TR Measurements 

TCSPC time (picosec. – microsec.)   

MCS time (microsec. – seconds)  excitation wavelength 
Excitation TRES 

TCSPC time (picosec. – microsec.)  excitation wavelength 

MCS time (microsec. – seconds)  emission wavelength 
Emission TRES 

TCSPC time (picosec. – microsec.)  emission wavelength 

Time Resolved Anisotropy TCSPC time (picosec. – microsec.)  measurement of vertical 
and horizontal polarisation 
plane 

 
The recognition of optional sample holders and accessories by the F900 software will automatically increase the 
measurement types available. For instance, temperature maps will be possible if cryostats or Peltier cooled 
sample holders are detected, spatial (sample) maps will be possible with sample X-Y stages or well plate reader 
attachment. 

The operating instructions in this section assume that the instrument has been started, the spectrometer is in full 
operating conditions and samples have been prepared. If this is not the case, follow steps 1-5 below: 

1. Switch on the PH1 power supply, the spectrometer controller, cooler power supply, and the Xe900 
xenon lamp power supply. 

2. Switch on the computer. 

3. Double-click the F900 icon or select F900 from your Start menu to start the software. 

4. Wait for the software to finish its initialisation process and component calibration. Once complete, the 
Signal Rate window is displayed: 

5. Setup the sample for measurements. (This might include the use of special sample holders and 
mounts.) 
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The following sections will instruct how to perform the different types of time resolved measurements listed in the 
table above, using the F900 spectrometer operating software. The following rule applies to all spectral scans: 

Use the Signal Rate dialogue box  to prepare for a lifetime measurement, then use the dialogue box for time 

resolved measurements ( quick access via ) to set up or modify scan parameters and to start the scan. 

 
It is important to routinely use the Signal Rate dialogue box, as this contains some items that can only be setup 
there and not in any of the dialogue boxes for time resolved measurements. This applies to bandwidth settings, 
attenuator settings, polariser settings. 

Even more than for spectral measurements it is important to pay attention to the signal rate levels, as for time 
resolved measurements different (lower!) saturation limits apply. These saturation limits depend on the rate of the 
exciting pulsed excitation source, For TCSPC the signal rate screen therefore contains the information about the 
repetition rate of the source. 

 

Figure 5-1: Signal Rate window for setting up time resolved measurements 

During the time resolved measurements the status bar on the button of the screen informs about the running 
activities, such as wavelengths and bandwidths settings, the sample temperature, angle of polarisation, etc. 

Active lifetime measurements can be aborted by using the “Stop” button of the active acquisition dialogue box. 

Details of the parameter settings of a completed measurement can be viewed in the Spectral Scan Properties. 
The properties can be accessed via right mouse click >> Properties if the active window contains only one 
measurement or via right mouse click >> Properties >> Measurement List if more than one scan is present in 
the active data window. 

 

5.1. Kinetic Measurements 
With Kinetic Measurements the time course of the signal is followed over a period of time, typically minutes, with 
a time resolution of a fraction of a seconds to seconds. Excitation and emission wavelengths remain fixed for the 
time of the measurement. 

The light from the excitation source (which is controlled by the excitation shutter) may be permanently on, or off, 
or may be switched on and off during the kinetic scan. 

To set-up and perform an emission scan... 
1. Use the Signal Rate dialogue box to set up measurement parameters, i.e. excitation and emission 

wavelength and band width. Ensure that the correct source (typically the steady state lamp Xe900) and 
the right detector have been selected. The photon count rate can be controlled by means of the 
attenuator (values between 1 and 100 are possible, note that the scale is not linear) and by means of 
the spectral band width in both the excitation and the emission beam path. For solid or film samples it is 
important that the impact of the sample positioning and orientation on the signal rate is to be checked at 
this point. 
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2. Close the Signal Rate dialogue box and open the dialogue screen Kinetic Scan Setup…. 
Set up the (overall) Scan Time and the Time Resolution. The combination of both will dictate the total 
number of data points, which is displayed for reference. This number can not exceed 10,000. 

3. Set up the options for the excitation shutter. If you select the option Timed, you can also decide when 
the shutter will open, and for how long it will remain open. 

4. Kinetic measurements may be corrected for fluctuations of the excitation light. Select the option Correct 
by Ref. Detector if you require this correction. The reference signal may also be recorded and 
displayed by ticking the box Display Ref. Data. The Display Ref. Data option is only available, if 
activated in Options >> Misc. Options.  

                                                      

Figure 5-2: Kinetic Scan Setup 

5. Start the map measurement: Start. 

A active kinetic measurement can be stopped by either pushing the Esc button or by clicking the  tool button 
on the top right of the F900 screen. Note that the Esc button will only be active if the window containing the scan 
is in focus. 

As wilh all other time resolved measurements, kinetic scans can be analysed by exponential fitting. This is 
available via Data >> Exp. Tail Fit. However, kinetic processes in the time regime of seconds or minutes often 
follow have more complex models than standard exponentials, the tail fit option might only provide a “crude” time 
constant for the overall decay (or ride) process. 

 

5.2. Manual Time Resolved Measurements – MCS 
This section describes how to make a time resolved measurement in multi-channel scaling mode. This mode 
requires an excitation source with low pulse repetition. The μF900H is the standard light source for this. 
Alternative light sources are available, refer to the FLSP920 Series Reference Guide for details. 

5.2.1. Operation of the μF900H 

The μF900H microsecond flashlamp is computer controlled in the way that it is triggered by the spectrometer 
controller. The unit has an integrated mains power supply that needs to be switched on separately (switch on the 
rear panel of the μF900H).  

The lamp will only provide optical output (flashes with the repetition rate that has been selected in the μF Setup 
window) when measurements are in progress, i.e. when the Signal Rate dialogue box is open or while performing 
a lifetime measurement (or a spectral scan). 

The lamp repetition rate can be set up via Setup >> μF Lamp Setup (refer to chapter 3.4.2 on page 31). This 
pulse repetition rate needs to be matched to the samples decay time. For samples with decay times in the 
millisecond range a repetition rate less than 100Hz may have to be selected to avoid background build-up. For 
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samples with decay times in the upper millisecond range, or even with seconds, selection of a very low repetition 
rate (<1Hz) is required. 

Detector gating is an optional accessory. Refer to the FLSP920 Series Reference Guide for further details. 

5.2.2. Measurement of a Phosphorescence Decay 

Photoluminescence decays in the time range of microseconds to seconds are called here (for convenience) 
phosphorescence decays although this might not always be scientifically correct. One of the biggest application of 
phosphorescence decays of this time range is the time resolved emission of lanthanides, and this is actually a 
special type of fluorescence.  

To set-up and perform a time resolved phosphorescence measurement ... 
1. Check the signal using the Signal Rate dialogue box. Ensure that the correct source has been selected 

(μF900H or alternative low repetition sources). The operation of a low repetition rate light source can 
usually be heart. Ensure excitation wavelength and emission wavelength have been appropriately 
selected. 

2. Having an understanding of the expected lifetime (or estimating the expected lifetime), review the pulse 
repetition rate of the light source. The pulse repetition period of the light source should not be shorter 
that 10 times the longest lifetime to be measured. If the pulse repetition rate of the light source needs to 
be changed, go to Setup >> μF Lamp  to do this. 

3. Continue to use the Signal Rate dialogue box. Check the detector signal (in cps). Ensure that the signal 
is not saturated. This is not easy and requires experience, as the saturation limit is not only linked to the 
lamp repetition rate, but also to the phosphorescence decay time, which you are about to measure. For 
a completely unknown sample use no more than 2000-3000cps as a signal to start with. Change the 
amount of signal by adjusting the Iris Setting and/or the band width in excitation and emission. 

4. Close the signal rate screen and open the dialogue box for manual lifetime measurements (  >> 
Manual). The dialogue box will appear on the right side of the F900 main panel and is divided into two 
dialogue fields. The upper filed will be required to start and stop measurements and provides an extract 
of Signal Rate options. The lower field is specific for the lifetime settings in multi-channel scaling mode 
(refer to Figure 5-3). 

 

         

Figure 5-3: Dialogue box for a manual time resolved measurement by MCS 
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5. In the upper field you can start (New), Stop, and Pause measurements. You also decide whether the 
new lifetime measurement is to be shown in a previous data window (Add – on the very right side), or in 
a new data window (NEW – very top right). For measurements of the phosphorescence decay the box 
IRF must be left blank. The lower part in the upper dialogue field is tabbed and some parameters 
inherited from the signal rate screen can be changed, if needed. However, monitoring of the detector 
signal as a result of those changes is not possible. 

6. The lower dialogue field is designed for set up the time-related measurement parameters. Time Range 
and Channels effect the full time window and the number of time bins within the full time range, 
respectively. Changing one of these two parameters will change the time calibration (in time/channel) 
that is displayed adjacent to these editable boxes. 

7. The Lamp Trigger Delay parameter will shift the position of the rising edge of the measurement along 
the time axis. An increase of the trigger delay value will cause a shift to the right. 

8. The Stop Conditions can be chosen between stop after a predefined number of Sweeps (light source 
flashes), stop after a predefined measurement Time (in seconds) or stop after a predefined number of 
Counts. If the latter stop condition has been selected, the option will be given to select a certain 
channel for which this stop condition will be valid. If this option is not chosen (box not ticked), the 
measurement will be stopped when the peak of the overall measurement has reached the stop 
condition. Note that with this stop condition option the measurement may take a little longer as the 
computer will become busy to search through each data sweep to find the maximum peak count, select 
one of the other stop conditions to avoid this potential delay. 

9. Start the measurement by clicking the NEW button. The measurement will stop when either the stop 
condition is reached, or when the STOP button is ticked. 

 

10. Start the measurement by clicking the NEW button. The measurement will stop when either the stop 
condition is reached, or when the STOP button is ticked. 

A time resolved phosphorescence decay measurement is typically analysed by fitting to a model function of one 
or more exponential parameters. This is available via Data >> Exp. Tail Fit.  

Time resolved phosphorescence decay measurements may also be analysed using numerical reconvolution 
(Data >> Exp. Reconvolution Fit). However, this is only possible, if the active window contains not only the 
phosphorescence decay, but also the corresponding instrumental response function (IRF). 

5.2.3. Measurement of the Instrument Response Function 

In a large number of cases, a measurement of the instrumental response function (IRF) will not be required for the 
analysis of phosphorescence decay measurements. The width of the IRF will be negligible small, compared to the 
intrinsic lifetime(s) of the decay, and analysis by the Tail fit routine will be sufficient. 

However, for the correct determination of short (<50μs) lifetimes, reconvolution will be necessary, and thus the 
IRF needs to be measured. 

To set-up and perform a measurement of the IRF ... 
1. Open up the Signal Rate screen, reduce the attenuator (Iris) to the minimum ( 1 ), then change the 

emission wavelength to a value identical to that of the excitation. This way you will be detecting the 
(Rayleigh) scattered light from the sample. It is important to note that attenuator is set to a minimum, 
and only if no light is detected then it should be stepwise increased while observing the detector signal 
rate. Reducing the attenuator alone might not even be sufficient to attenuate the signal: For a correct 
measurement of the IRF the signal should be no more than 1000cps (for a lamp operating at 100Hz). A 
scatterer (such as Ludox) may be used instead of the sample. This way the risk is eliminated that a 
fraction of photoluminescent light “contaminate” the IRF measurement. 

2. Close the signal rate screen and open the Manual lifetime measurement screen. After step 1. above it 
is not recommended now to change any of the parameters. Changing sample parameters (such as 
excitation or emission wavelength) would result in a change of the signal rate that had been critically set 
up, changing time-related parameters must not be done, as the IRF must be measured under identical 
time-related conditions as the phosphorescence decay. 
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3. Before starting the IRF measurement pay attention that the box IRF has been ticked. This way the 
software will recognise the measurement as an IRF measurement (and not a sample decay). This 
identification is important for the subsequent data analysis. It is also recommended to add the IRF 
measurement to the data window that was used for the sample decay measurement, as for the analysis 
the window must contain the decay and the IRF. 

If you forget to tick the box IRF before you start to acquire data, then you can still identify the IRF after the 
measurement has been completed. Access the measurement properties (right mouse click >> Properties >> 
(Properties)) and tick the box Is Instrument Response on the bottom left of the property display. 

4. The IRF is typically measured to the same peak height as that of the decay measurement. But this is 
not absolutely necessary for the subsequent data analysis. Start the measurement (New). 

5. On completion of the IRF measurement this can be used in the analysis of the phosphorescence decay. 
Refer to chapter 7.6 on page 98. 

 

5.3. Manual Time Resolved Measurements – TCSPC 
This section describes how to make a time resolved measurement in Time Correlated Single Photon Counting 
mode. This mode requires an excitation source with high pulse repetition rate. The nF920 is the standard light 
source for this. Alternative light sources are available, refer to the FLSP920 Series Reference Guide for details. 

 

5.3.1. Operation of the nF920 

Principle features of the nF920 nanosecond flashlamp are described in section 2.1.3 of this manual, starting at 
page 15. The lamp operation is computer controlled, this is made via the setup dialogue box nF lamp setup that 
is described in section 3.4.1 on page 30. 

This section assumes that the nF920 is in full working conditions. This means: 

The lamp has been recently cleaned and all instructions have been followed to put the lamp back in operating 
conditions. If this is not the case the lamp will most likely not run properly. Refer to the FLSP920 Series 
Reference Guide for instructions on the cleaning, re-alignment and refilling procedure. 

Start-up of the Nanosecond Flashlamp 
1. If it has not been done yet, switch on the nF920 power supply and wait at least 5min, allowing the 

thyratron trigger within the lamp head to heat up. This is a good time to re-check the gas pressure, 
cables, gas tubes and optical fibre. The gas pressure is viewed in the nF920 lamp setup menu, this is 
accessed via Setup >> nF Lamp Setup.  

 

Figure 5-4: nF Lamp setup screen before start-up 
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2. The operational parameters displayed will not have changed from the last operating session. Double 
check that these are the parameters you want to use this time again.  For standard operating conditions 
this is EHT=6.8kV and Frequency=40kHz, refer to the FLSP920 Series Reference Guide. For normal 
start-up, the Auto Start option located beneath the ON/OFF button is selected.  

3. A critical parameter at this point is the gas pressure. Ensure the gas pressure is as required (0.45bar 
±0.05bar for standard operating conditions, refer to the FLSP920 Series Reference Guide). If the gas 
pressure is incorrect the lamp will not operate, a gas refill or even a complete maintenance cleaning 
might be required. 

4. When the warm-up period of approximately 5 min (from the time the nF920 power supply was switched 
on) has expired, switch the lamp on by clicking on the Switch Lamp ON button. This will switch the 
EHT on and will stepwise ramp up the frequency (Auto-Start). After 2-3 seconds the auto-start-up has 
been completed and measured lamp parameters should be displayed accordingly, refer to Figure 3-3 on 
page 30. 

The lamp is in proper operating conditions when the measured frequency is stable within the range of ±50Hz. 
Initially this tolerance interval may be exceeded, but after 2-3 min of operation the lamp should be stable. If it is 
not, re-gas filling, or even re-servicing the lamp will be required. 

 

5.3.2. Measurement of a Fluorescence Decay 

Photoluminescence decays in the time range of picoseconds and nanoseconds are called here (for convenience) 
fluorescence decays although this might not always be scientifically correct. As heavily quenched 
phosphorescence decay processes might also fall into this time range. 

To set-up and perform a time resolved fluorescence measurement ... 
1. Check the signal using the Signal Rate dialogue box. Ensure that the correct source has been selected 

(nF920 or alternative high repetition rate sources). Correct operation of the high repetition rate light 
source can be verified by the frequency that is displayed on the upper of the two signal rate bars, refer 
to Figure 5-1 on page 67 Ensure excitation wavelength and emission wavelength have been 
appropriately selected. 

2. Having an understanding of the expected lifetime (or estimating the expected lifetime), review the pulse 
repetition rate of the light source. The pulse repetition period of the light source should not be shorter 
that 10 times the longest lifetime to be measured. For sample excitation with the standard nF920 flash 
lamp (operating at 40kHz) the repetition rate is – for the vast majority of lifetime measurements – low 
enough and there will be no need to further reduce the repetition rate. However, for alternative TCSPC 
light sources with much higher pulse repetition rates the issue of selecting an appropriate pulse rate is 
of significant relevance. 

3. Continue to use the Signal Rate dialogue box. Check the detector signal (in cps). Ensure that the signal 
is below saturation and pulse pile-up level. With TCSPC the signal count rate from the detector should 
not exceed more than 5% the rate of the exciting light source. For operation with the standard 
nanosecond flashlamp (40kHz) this means the detector signal must not exceed 2000 counts per 
second. Change the amount of signal by adjusting the Iris setting and/or the band width in excitation 
and emission. 

4. Close the signal rate screen and open the dialogue box for manual lifetime measurements (  >> 
Manual). The dialogue box will appear on the right side of the F900 main panel and is divided into two 
dialogue fields. The upper filed will be required to start and stop measurements and provides an extract 
of Signal Rate options. The lower field is specific for the lifetime settings in multi-channel scaling mode 
(refer to Figure 5-5). 
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Figure 5-5: Dialogue box for a manual time resolved measurement by TCSPC 

5. In the upper field you can start (New), Stop, and Pause measurements. You also decide whether the 
new lifetime measurement is to be shown in a previous data window (Add – on the very right side), or in 
a new data window (NEW – very top right). For measurements of the fluorescence decay the box IRF 
must be left blank. The lower part in the upper dialogue field is tabbed and some parameters inherited 
from the signal rate screen can be changed, if needed. Changes will be made after the Apply bottom 
has been ticked. 

6. The lower dialogue field has a display of the two rates: Start Rate = pulse repetition rate from the 
exciting source; Stop Rate = signal count rate from the detector. Use this dialogue field also to set up 
the time-related measurement parameters. Time Range and Channels effect the full time window and 
the number of time bins within the full time range, respectively. Changing one of these two parameters 
will change the time calibration (in time/channel) that is displayed adjacent to these editable boxes. The 
Options box is for an advanced setup of detector thresholds, delays, etc. For standard spectrometers 
there should be no need to change any of those settings. 

7. The Stop Conditions can be chosen between stop after a predefined measurement Time (in seconds) 
or stop after a predefined number of Counts. If the latter stop condition has been selected, the option 
will be given to select a certain channel for which this stop condition will be valid. If this option is not 
chosen (box not ticked), the measurement will be stopped when the peak of the overall measurement 
has reached the stop condition. This is perhaps the most commonly used stop condition in TCSPC 
measurements, most measurements will be stopped with the value set to 10000 counts. 

8. Start the measurement by clicking the NEW button. The measurement will stop when either the stop 
condition is reached, or when the STOP button is ticked. 

A time resolved fluorescence decay measurement may be analysed by fitting to a model function of one or more 
exponential parameters. This is available via Data >> Exp. Tail Fit.  

Note that the tail fitting procedure is only applicable for fluorescence decays that are not affected by the finite 
width of the instrumental response function. With a width of the IRF of 1-2ns (for operation with the standard 
nF920 lamp), tail fitting will only provide satisfactory results for lifetimes greater than 10ns. 

Lifetimes shorter than this must be analysed using numerical reconvolution (Data >> Exp. Reconvolution Fit). 
However, this is only possible, if the active window contains not only the fluorescence decay, but also the 
corresponding IRF. 
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5.3.3. Measurement of the Instrument Response Function 

For the analysis of a fluorescence decay by numerical reconvolution an instrument response function needs to be 
obtained. The IRF contains the information about the time response of the overall optical and electronic system. 
Only a correct measurement of this information, and the use of this information in the process of analysis, will 
result in accurate results and lifetimes that can be trusted. 

To set-up and perform a measurement of the IRF ... 
1. Open up the Signal Rate screen and change the emission wavelength to a value identical to that of the 

excitation. This way you will be detecting the (Rayleigh) scattered light from the sample. For a 
measurement of the IRF the rules of saturation apply, too. This means the scattered light signal should 
not exceed 4000cps, if the standard light source nF920 is being used. The level of signal can be 
controlled by adjusting the signal attenuator (Iris) Sometimes a change in the bandwith setting is 
required to further adjust the scattered light level. For an accurate measurement of the IRF a scatterer 
(such as Ludox) may be used instead of the sample. This way the risk is eliminated that a fraction of 
fluorescent light “contaminate” the IRF measurement. 

2. Close the signal rate screen and open the Manual lifetime measurement screen. After step 1. above it 
is not recommended now to change any of the parameters. The IRF must be measured under identical 
conditions compared to the previous measurement of the fluorescence decay. 

3. Before starting the IRF measurement pay attention that the box IRF has been ticked. This way the 
software will recognise the measurement as an IRF measurement (and not a sample decay). This 
identification is important for the subsequent data analysis. It is also recommended to add the IRF 
measurement to the data window that was used for the sample decay measurement, as for the analysis 
the window must contain the decay and the IRF. 

If you forget to tick the box IRF before you start to acquire data, then you can still identify the IRF after the 
measurement has been completed. Access the measurement properties (right mouse click >> Properties >> 
(Properties)) and tick the box Is Instrument Response on the bottom left of the property display. 

4. The IRF is typically measured to the same peak height as that of the decay measurement. But this is 
not absolutely necessary for the subsequent data analysis. Start the measurement (New). 

5. On completion of the IRF measurement this can be used in the analysis of the fluorescence decay. 
Refer to chapter 7.6 on page 98. 

 

 

5.4. Multiple Time Resolved Measurements 
This measurement option provides a tool to automatically acquire a series of time resolved measurements 
(TCSPCS or MCS) by repeating the measurements with or without a preset delay (waiting time). All data is stored 
together in a single container file.  

Typically a Multiple Time Resolved Measurement is made to establish a possible change in the decay process 
over a longer period of time. It is recommended that single measurements on this or a similar sample have been 
made before (refer to section 5.2 on page 68 for MCS measurements and section 5.3 on page 70 for TCSPC 
measurements). This way you have a background knowledge on the sample specific settings (such as 
wavelength and bandwidth) and on time range specific settings (such as the required time range and suitable stop 
conditions). 

To set-up and perform a Multiple Time Resolved Measurement ... 

1. Open up the dialogue box for multiple time resolved measurements (  >> Multiple). For repeated 
measurements of an IRF tick the box Instrument Response. For a repeated measurement of a sample 
decay you leave this box un-checked. Define the number of measurements you want to do (Measure 
this sample ...). The box Save data each time will most likely remains un-ticked. This way each of the 
measurements will start from Zero. (With the box checked a new measurement cycle would add the 
new data to the previous result, effectively continuing the old measurement.) 
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Figure 5-6: Setup of multiple time Resolved measurements 

2. Do not start the multiple measurement yet! It is important to review sample and time settings before you 
start. For Multiple Time Resolved Measurements the sample specific settings (such as excitation and 
emission wavelengths and band width, iris settings) are inherited from the Signal Rate window. These 
settings can be reviewed and changed in the Sample Set Up box. In contrast, time specific settings 
(such as time range, number of channels, stop conditions) are inherited from the Manual measurement 
dialogue box. These settings can be reviewed and changed in the Time Set Up box. A typical oversight 
is the setup of appropriate stop conditions that applies for the individual measurements. 

3. Now start the multiple measurement: Start. 

A ongoing multiple measurement can be stopped by either pushing the Esc button or by clicking the  tool 
button on the top right of the F900 screen. Note that the Esc button will only be active if the window containing the 
scan is in focus. 

 

 

5.5. TRES-Map Measurements 
Time Resolved Emission (or Excitation) Map Measurements is a powerful tool in time resolved fluorescence 
spectroscopy. TRES-Map measurements consist of a series of time resolved measurements (TCSPC or MCS) 
with the emission (or excitation) wavelength systematically stepwise changed. This Map measurement can be 
converted to time resolved emission (or excitation) spectra (TRES). These spectra can provide information that 
goes far beyond that from (conventional) spectra by steady state fluorescence spectroscopy. 

Time resolved emission measurements are also used for more detailed analysis by numerical curve fitting. For 
example, systematically changes of the lifetime when changing the wavelength may be revealed. Alternatively, 
the set of lifetimes may remain constant when scanning over the wavelength, but the amplitude of the lifetime 
components may systematically change instead. Refer to that advanced data analysis FAST provided by 
Edinburgh Instruments. 

5.5.1. Excitation TRES-Map Measurements 

TRES-Map measurements with the excitation wavelength systematically changing are only available when a 
TCSPC source is used that has a broad spectrum and the wavelength for excitation is controlled by the F900 
software. The standard nF920 is such a source. 

To set-up and perform an Excitation TRES Measurement ... 
1. Prior to setting up a TRES-Map measurement use the facility for Manual time resolved fluorescence 

measurements to perform test measurements (refer to section 5.2 on page 68 for MCS measurements 
and section 5.3 on page 70 for TCSPC measurements). This way you gain knowledge on the sample 
specific settings (such as wavelength and bandwidth) and on time range specific settings (such as the 
required time range and suitable stop conditions) and the time it takes for a single curve to be 
measured. 
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2. Open the dialogue box for setting up Excitation TRES-Map measurements (  >> TRES >> 
Excitation). Select the range of excitation you want to cover and choose the step size. Select a step 
size that is consistent with the spectral band width in the excitation channel. Also, be aware of the 
number of individual lifetime measurements that is to be performed within the selected spectral range. 
The emission wavelength is inherited from the Signal Rate box, if required, this might be changed here. 
Leave the tick-box Instrument Response un-checked. 

 

Figure 5-7: Excitation TRES-Map setup dialogue box 

3. Do not start the TRES-Map measurement before you have reviewed the sample and time settings. For 
the TRES-Map measurement the sample specific settings (such as excitation and emission band width 
and iris) are inherited from the Signal Rate window. These settings can be reviewed and changed in 
the Sample Set Up box. In contrast, time specific settings (such as time range, number of channels, 
stop conditions) are inherited from the Manual measurement dialogue box. These settings can be 
reviewed and changed in the Time Set Up box.  

4. Now start the TRES measurement: Start. 

A ongoing TRES-Map measurement can be stopped by either pushing the Esc button or by clicking the  tool 
button on the top right of the F900 screen. Note that the Esc button will only be active if the window containing the 
scan is in focus. 

 

5.5.2. Emission TRES-Map Measurements 

Emission TRES-Map measurements are probably more common than Excitation TRES-Map measurements, as 
they can be converted into time resolved emission spectra. In difference to Excitation TRES-Maps they also do 
not require a broad band excitation source. 

The setup of Emission TRES-Map measurements is similar to those of Excitation TRES. Refer to Figure 5-8 and 
the instructions given in the previous section. Note that stop conditions for the individual lifetime measurements 
(via Time Set Up) must be set to Time, if you want to generate time resolved emission spectra from your set of 
TRES data. 
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Figure 5-8: Emission TRES-Map setup dialogue box 

 

 

 

5.6. Time Resolved Anisotropy Measurements 
The measurement of time resolved fluorescence anisotropy requires computer-controlled polarisers in both the 
excitation and the emission channels (optional accessory for all FLSP920 spectrometers). Linearly polarised light 
of vertical (V = 00) and horizontal (H = 900) orientation are used to excite the sample and detect the sample 
emission. See the FLSP920 Series Reference Guide for more details on the FLSP920 polariser accessory. 

Either four ( IVV(t), IVH(t), IHV(t), IHH(t) ) or two ( IVV(t) and IVH(t) ) time resolved measurements are required for the 
calculation of the anisotropy function, depending whether G-factor correction is applied or not. The equations and 
definitions used in the calculations are given in the formula section on page 103, equations (7) – (9). See also the 
FLSP920 Series Reference Guide for further details on the time resolved fluorescence anisotropy. 

Before performing time resolved anisotropy measurements, it is required that you have a background knowledge 
of the sample’s excitation and emission properties. It is also important that you know the spectral excitation 
anisotropy, as a bad choice of the excitation wavelength can result in a Zero anisotropy, even if the sample has 
strong absorption and rotational correlation times in the nanosecond time range. It is also recommended that you 
know the time scale of the fluorescence decay (not affected by anisotropy). This is ideally done by time resolved 
fluorescence measurements, as described in section 5.3, on page 71, with the polarisers in magic angle 
configuration. But even “normal” fluorescence lifetime measurements will provide good background information. 

Time resolved fluorescence anisotropy measurements reveal information about the ability of the average 
assembly of molecules to rotate during the short period of being in the excited state. For most fluorophores 
anisotropy effects are only observed when the solvent is of high viscosity (glycerol, mineral oil), or if the 
fluorophores are attached to slowly rotating macromolecules (bound to proteins or embedded into membranes). 
For these systems the rotational diffusion time and the fluorescence lifetime are similar – a condition for 
anisotropy effects to be observed. In low viscosity solvents (water, ethanol, etc) or in frozen samples time 
resolved fluorescence anisotropy is generally not seen as the rotation effects are either too fast or to slow, 
respectively. 

Due to these time range limitations, time resolved fluorescence anisotropy measurements are practically 
exclusively made in TCSPC mode with high repetition light sources for sample excitation.  

Before you can start making the polarised measurements you must move the polarisers into the beam path. This 
is described in section 4.5 on page 53.  
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Performing Time Resolved Fluorescence Anisotropy Measurements 
1. Prior to performing time resolved fluorescence anisotropy measurements, use the Signal Rate dialogue 

box to set up measurement parameters such as excitation and emission wavelength, spectral band 
width of excitation and emission. Ensure that the correct source (typically the nF920 nanosecond 
flashlamp or an EPL) and the right detector have been selected. 

2. Still using the Signal Rate dialogue box, check the signal levels for all four combinations of polariser 
orientations: Excitation polariser = 0o, 90o, Emission polariser = 0o, 90o. Ensure that non of the signal 
count rates exceeds the pile-up limit of about 5% of the source’ start rate; adjust the attenuator and/or 
monochromator slits accordingly. 

3. Open the dialogue box for time resolved anisotropy measurements (  >> Anisotropy - Figure 5-9) 
From within this dialogue box you can set up and start single and multiple time resolved anisotropy 
measurements. For a single anisotropy measurement, set the Measure this Sample value to 1. For 
multiple measurements set this value to the total number of anisotropy measurements you intend to 
make. If you do multiple scans, you can define a waiting time between the individual measurements. 

4. The value Polariser Repetition applies to both single and multiple anisotropy measurements. A value 
of 5 (as shown in Figure 5-9) means the set of polarised time resolved measurements will be repeated 5 
times, with each repeat the acquisition will continue to add the counts to the previous data. 

5. The lower section of the dialogue box is for setting up the type of G-factor correction. With the option 
Fixed value of chosen, no additional measurements will be made for obtaining G-factor correction. This 
option is best (as it is time saving) if you know the G-factor from previous measurements – you simply 
enter the known value. You can also select the option to measure the G-value, either by doing the two 
additional lifetime measurements IHH(t) and IHV(t) and subsequent integration and ratioing (Measure 
now by integrating TCSPC), or by acquiring the signal amplitude for the IHH and IHV settings for a pre-
defined duration of time. The latter of the two options is typically faster, but might not be as accurate. 

 

Figure 5-9: Setup for automated time resolved fluorescence anisotropy measurements 

6. Do not yet start the measurement! Review first the sample specific settings (Sample Set Up) and the 
time specific settings (Time Set Up). The sample specific settings (such as excitation and emission 
wavelength and band width, iris setting) are inherited from the Signal Rate window and should therefore 
be all right, provided you have followed step 1. above. The time specific settings are inherited from your 
last Manual time resolved measurement. A typical oversight is the setup of the appropriate stop 
conditions: For time resolved anisotropy measurements these must be set to Time to get meaningful 
results. 
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Figure 5-10: Raw polarised time resolved measurements 

7. During the acquisition process of the raw polarised time resolved data the software will automatically 
acquire two or four curves, depending on the mode of G-factor correction. The status of the 
measurement will be shown in the status bar the bottom of the screen. At the end of the measurement 
the anisotropy function will be calculated and displayed in a separate window. The G-factor can be 
viewed in file properties (right mouse click . Properties). 
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Figure 5-11: Example of the final time resolved anisotropy curve 

The anisotropy curve can now be numerically analysed to obtain the characteristic rotational diffusion time(s). For 
the analysis please bear in mind that only exponential tail fit is applicable (select Data > Exp. TailFit…). 
Anisotropy analysis models that also allow numerical reconvolution are available in the advanced data analysis 
software FAST. 

For proceeding with tail fit analysis it is important to select the correct fitting range. In particular the start channel 
should not be allowed to be in the noise before the decay, this inevitably will result in unsuccessful fits. It further 
should be noted, that, together with the calculation of the anisotropy curve the variances for each data channel 
were calculated and they are (invisibly) attached to the anisotropy data. The correct variances will be used in the 
analysis to produce the correct weighting factors for the data. 
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5.7. Tips for Making Good Lifetime Measurements 
Good time resolved measurements require background knowledge of the sample to be measured, i.e. knowledge 
about the absorption properties and emission properties. It therefore is desirable that you measure excitation and 
emission scans first, before attempting lifetime measurements. You are also referred to section 4.8 for tips on 
making good spectral measurements, starting on page 60 of this user guide. 

Time resolved measurements, however, have specific issues, and they are outlined below: 

 

Tips for time resolved measurements: 
 

1. Inner Filter Effect 

 

As for spectral measurements, the inner filter effect should be avoided. This effect will reduce the signal that is 
available for the lifetime measurement. 

If inner filter effect is present, and the sample has a strong overlap between absorption and emission, re-
absorption may occur. This can artificially increase the value of the measured lifetime (in the nanosecond time 
scale). 

The same tips apply as outlined in section 4.8 for the inner filter effect. 

 

2. Scatter from the Source 

 

Scattered light from the source might passes the emission monochromator in first or second order, and this 
interferes with the time resolved measurement. 

This type of interference is recognised by a narrow initial spike “on top” of the decay. With measurements in the 
microsecond and millisecond regime this narrow initial scatter spike might be just discarded in the data analysis. 
With decay measurements in the nanosecond time scale and (unwanted) IRF superimposes the fluorescence 
decay. The region of the IRF might either be discarded in the data analysis, or the additional IRF is numerically 
treated in the reconvolution process (by adding an additional component with a fixed very short lifetime). 

Tip: 

o Use a wavelength cut-off filter (blocking at shorter, transmitting at longer wavelength) in the emission beam 
path (behind the sample) to block the scattered spike from the source. 

o Discard the “contaminated” region during the data analysis process. 
 
 
 

3. Weak Sample Emission 

 

The sample shows very weak emission. What options are there to increase the signal? 

Tips: 

o The utmost important task is to check the positioning of the sample in the sample compartment. A visible 
inspection of the sample excitation is recommended (look at the sample when the Signal Rate screen is 
open). If the excitation is outside the visible spectrum, or the light is too weak to be seen by the naked eye, 
you might change the excitation temporarily to 500nm for an assessment of the situation. You might even 
change to another light source (such as the Xe900) for the assessment of the alignment situation.  

o The sample volume of a liquid sample might be too low. Increase the volume, use a micro-cuvette, or raise 
the cuvette. 

o Bulk or film samples might have to be re-positioned. 
o Increase the spectral band pass.  
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Please note: With very wide spectral band widths there is an increased risk to measure stray light that passes 
through the monochromators. There is also an increased risk to accidently over-expose the detector. 

It is worth noting that TCSPC measurements (although they might take very long) can still yield good results even 
if the signal is as low as the background (a few counts per second). The reason for this is that background 
photons will be distributed over the full second, whereas the TCSPC data will only be acquired when the time 
window has started by trigger pulse from the source. 

 

 
4. Pulse Pile-Up on Signal  (TCSPC) 

 

Pulse Pile-Up is only a problem in TCSPC measurements, where only one detector count can be accepted for a 
flash cycle of the excitation source. If more than one detector count arrive at the electronics in a measurement 
cycle, only the first one is “seen” and the others are ignored. This will skew the decay measurement towards 
shorter lifetimes. To avoid this effect the stop rate should never be higher than 5% of the start rate. [For very 
accurate determinations of lifetimes one should not go beyond 2%, for “quick and rough” acquisitions 10% might 
be acceptable.] 

Tips: 

o Attenuate the signal to a level that avoids pulse pile-up (below 5% of the start rate). 
o Use a start repetition rate that is sufficiently high 
 
 
 

5. Pulse Pile-Up on Background  (TCSPC) 

 

Pulse Pile-Up may also occur on background, if the background count rate is very high, for example with modern 
NIR-PMTs. The consequence of this type of pulse pile-up is a sloping background level in the resulting TCSPC 
measurement. 

Tips: 

o Try to use the detector in a mode that gives the lowest detector background count rate. 
o Use a start repetition rate that is sufficiently high. 
 
 
 

6. Signal Saturation  (MCS) 

 

Multi-channel scaling measurements, particularly those short decays and scatter in short time ranges, can be 
severely affected saturation. The reason for this is that the number of photon pulses that can “fit into each time 
bin” is limited. For very narrow time bins this number can be as low as 5 per lamp flash, and with the lamp 
flashing at 100Hz, the limit for a single bin would be 500 per second. 

Tip: 

o Measure an unknown sample with no more than 2000-3000 cps. The signal may then be increased if the 
sample decays in milliseconds. The signal might even have to be decreased if the sample decay time is only 
a few microseconds. 
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Tips specific for time resolved anisotropy measurements: 
 

7. G-Factor 

 

A correct G-factor is essential for a good anisotropy measurement.  

Tips: 

o A precision of the G-factor to 2 decimal place is required. 
o The G-factor can be viewed and edited by selecting the window containing the original polarised lifetime 

measurements and then selecting Data > Anisotropy Analysis. 
o Modifying the G-factor manually allows to assess the impact of the G-factor on the final anisotropy curve. A 

G-factor that is too small will shift the anisotropy towards negative values, a G-factor that is too big will result 
in an anisotropy that is too positive. 

o An unambiguous test for the correctness of the G-factor is to use a sample where the fluorophores are in a 
low viscous environment (e.g. water, ethanol). For those samples the anisotropy is expected to be Zero (the 
data are randomly distributed around Zero). The G-factor is correct when the time resolved data are 
distributed around Zero. 

o In some cases even the positioning of the sample or the replacement of filters can have an effect on the G-
factor. Careful handling and/or alternative methods for the G-factor determination are required. 

 

 
8. Weak Signal 

 

As time resolved anisotropy measurements consist of a series of time resolved measurements, with several 
cycles and sometimes reduced signal levels due to the additional optical elements polarisers, acquisition times 
can be significantly longer than normal fluorescence lifetime measurements.  

Tip: 

o Use a higher number of cycles (polariser repetitions) instead of long acquisition times for the individual 
lifetime acquisitions. This averages potential sample or light source fluctuations, but also allows an early 
assessment of the polarised measurements. 

 

 
9. Alternative Ways for G-Factor Measurements 

 

If time resolved fluorescence anisotropy measurements are made by using EPLs or titanium sapphire lasers as 
excitation sources, the polarisation plane of excitation can not be computerised rotated for G-factor acquisitions. 

Tips: 

o EPLs can be manually rotated. Once the emission is in the horizontal plane a full anisotropy measurement 
with G-factor correction can be performed. The resulting anisotropy will be meaningless and has to be 
rejected, but the G-factor that can be accessed via the properties can then be used for further anisotropy 
measurements (when the EPL is operating in the vertical plane again. 

o The polarisation plane of a Titanium Sapphire laser can be rotated by means of a Soleil Babinet 
compensator or by a lambda-half plate. Similar to the procedure given for EPLs above the G-factor can be 
obtained. 

o An alternative way to obtain the G-factor is to use a sample where the fluorophores are in a low viscous 
environment (e.g. water, ethanol). For those samples it is expected that the time resolved anisotropy is 
randomly distributed around Zero for all data channels. Using the Data > Anisotropy Analysis dialogue an 
estimate for the G-factor can be iteratively obtained. 
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10. Manual Measurement of Time Resolved Fluorescence Anisotropy 

 

Time resolved anisotropy measurements can also performed manually, either by setting the polarisers to 00 and 
900 in the signal rate screen, or by even using non-standard polarisers such as dichroic sheet polarisers.  

Tips: 

o If manual anisotropy measurements are made using the standard computer controlled polarisers the 
polarisation angle is registered by the software and as long as at least the IVV and the IVH measurement are 
contained in the same window the anisotropy can be calculated using Data > Anisotropy Analysis. 

o If polarisers are used that are not recognised by the software the polariser orientation can be edited 
manually in the properties of the measurement. Access the file properties (right mouse click on the graph) 
and select Properties. On the bottom right side of the scan properties tick the button Edit Values, then 
change the polarisation angle from none to either 0 or 90. Once the polarisation angle is edited and provided 
the active window contains at least IVV and the IVH the anisotropy can be calculated using Data > Anisotropy 
Analysis. 
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6. Data Operations on Spectral Data 
A variety of the data operation tools and data analysis options is available to spectral data. Some data 
manipulation options are common to both spectral and lifetime data, others are specific. Therefore, the list of 
options that is available by clicking the pull down menu Data will vary depending on the data file type. 

A summary of the data operation tools and data analysis options for spectral and time resolved data is given in 
section 3.7. “Data Operation and Analysis with F900” on page 42 of this User Guide. 

This section describes in detail how to use the standard data operation tools for spectral data. A range of non-
standard data operation tools is available. They may be activated via Options >> Analysis Options >> Spectral 
Data. These advanced options require data that can only be measured with special hardware (integrating sphere, 
absorption accessory). For a description on these tools refer to the FSLP920 Series Reference and 
Maintenance Guide.  

 

6.1. Add, Subtract, Multiply, Divide 
With these data operation options a single spectral scan (of a set of spectral scans) can be added to (subtracted 
from, multiplied or divided) to another spectral scan. 

For example, to add two different curves together, open the dialogue box Data > Combine > Add… (refer to 
Figure 6-1. The list that is provided within this dialogue box contains all data windows that are open or minimised 
within the F900 program. The sequence is in order of time accessed. In the example of Figure 6-1 the spectral 
scan Example Data 2 will be added to the scan Example Data 1. Instead of Example Data 2 another 
measurement may be picked that may also be in the data container Example Data Set. Double click on the 
container to open it. To return to the original list of files and containers click on the  icon that will have opened 
up on the top right of the dialogue box. 

 

Figure 6-1: Add spectral scans 

The spectral scans to be added must have the same step size. It is not necessary that they have the same 
spectral coverage. If the spectral ranges do not fully overlap the resulting file will extend from the minimum of the 
two files to be added to the maximum of those files. The data that are not available are automatically treated as 
Zero. 

The resulting curve(s) can be added to the original window, or they can be shown in a new data window. This is 
selected by the corresponding radio buttons on the lower part of the dialogue box. 

By clicking the Apply button the numerical operation will be processed and the new data will be demonstrated. 
The dialogue box will remain open for further data adding. Selecting OK, in contrast,  will perform as with Apply, 
but will automatically close the dialogue box. 
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6.2. Append 
The Append operation is only available to spectral data and correction scans. It has been designed for the 
purpose of joining spectral scans of different spectral ranges into one. The Append function will only work if the 
two different spectral scans to be joined have at least one overlapping wavelength point. The spectral scan that is 
to be appended on must have a spectral coverage that is at shorter wavelengths than the one that will be 
appended with. 

In contrast to the other Combine operations described in sections 6.1 to 6.2, only a single spectral scan can be 
appended on. If the active data window contains more than one scan the Append option will not be available.  

Layout and functionality of the Append dialogue box are similar to the those described in sections 6.1. The 
difference is additional information and select options that are given beneath the list of data. 

 

Figure 6-2: Append dialogue box 

If the selected file fulfils the conditions that are required to append it to the original file the overlap range will be 
displayed and the option will be given to select a wavelength within the overlapping range (centre of the overlap 
as default). The selected wavelength in the Append at box has no function if the No matching option has been 
selected. However, if either Scale or Offset have been selected, the data that will be appended to the original 
curve will be scaled or offset so that they match the original curve at that selected wavelength. The resulting 
spectrum will have the data of the original curve up to the wavelength selected in Append at and will have the 
scaled of offset data of the second curve from there onwards. An averaging in the overlapping range is not 
provided. 

 

6.3. Scale, Normalise, Subtract Baseline, Crop Range 

Scale 
The Scale operation multiplies a single measurement or a set of measurements contained in a single data 
window by a factor.  

 

Figure 6-3: Dialogue box for scaling data 
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By selecting Scale from the Data menu the dialogue box as shown in will open up. The scaling factor may be 
edited and the option for the display of the resulting curve may be selected. 

Note that a negative scaling factor is possible, this can be used to invert the data. Note that a scaling factor of 
Zero is not possible. 

This scaling will apply to all curves that are contained in the data window. Apply will process and display the data, 
but will keep the dialogue box open. OK will process the data and will automatically shut down the dialogue box.  

 

Normalise 
The Normalise operation scales a single measurement or a set of measurements contained in a single data 
window by a factor, so that the resulting curve(s) have a peak value that is given in the “to” edit box, see Figure 
6-4. For a set of scans, the peak of the individual scans will not necessarily be a the same wavelength. 

The “to”-value can be manually edited. Alternatively a curve is selected in the list of files below. As soon as a 
single measurement is highlighted, the maximum of this measurement will be found and will be displayed in the 
“to” box. If a measurement container is highlighted the maximum of all curves in that container will be shown. 

 

 

Figure 6-4: Normalise dialogue box 

Normalisation to negative numbers will invert the data and all data will have a common minimum value. 
Normalisation to Zero will set all curves to Zero. 

Note that when original data are displayed in the logarithmic scale, the resulting data may not be suitable for 
demonstration in this way, e.g. when curves are normalised to ≤ 1. The user may have to change the graph to 
linear scale. In some cases even that may not be sufficient to view the data and the Scale from Baseline box 
might have to be un-checked (right click on the graph / Plot Options / Spectral / …) 
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Subtract Baseline 
This option is for subtraction a stationary background, form a single spectral scan, or from a set of spectral scans.  

 

Figure 6-5: Subtract baseline 

The number that is displayed in the editable filed will be subtracted from the data of the active data window. Upon 
opening the dialogue box the editable filed is normally blank. An exception is a raw single scan that was 
measured without automatic background subtraction. As the background had been recorded, it is now displayed 
as a default value for manual background subtraction. 

The function may be use to artificially add a background to the data. In this case the Baseline value would be a 
negative number. 

 

Crop Range 
Spectral scans may be cropped, i.e. the spectral range may be cut back. This function is useful for removing 
unwanted data from the left or the right side of the graph, in particular if the Append function (see section 6.2) is 
to be used afterwards. 

To crop the data range of a single curve or a number of curves in the active data window, open the dialogue box 
and edit the default values. The default values are the far left and the far right extremes of the current data range. 

 

Figure 6-6: Crop Range dialogue box 

 

 

6.4. Smooth 
Spectral data can be smoothed. The binomial smoothing technique is applied, with the option to include between 
1 and 4 neighbouring data points on either side of each point to be smoothed (≡ Number of Points between 3 
and 9, respectively). 
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Figure 6-7: Smooth dialogue box 

Note, excessive smoothing may alter real spectral features. Smoothing is best performed on oversampled data, 
i.e. curves with high number of data points for the spectral features involved. 

 

6.5. Differentiate and Integrate 

Differentiate 
Use this data operation to differentiate the spectral scans. Derivatives of the first order, the second order, even up 
to the 4th order can be performed. For the reduction of noise, smoothing can be applied prior to differentiation.  

 

Figure 6-8: Differentiate dialogue box 

 

Integrate 
The Integrate operation is only available for spectral data. The integration of the whole spectral scan will be 
performed, starting at the short wavelength side and ending at the data point of the longest wavelength. Thus, the 
longest wavelength data point of the resulting integrated curve represents the integral number of the whole 
original curve. 

If an integral number is required of a range that starts at longer wavelengths than the first data point of the original 
scan, then you must either crop the original scan on the short wavelength side before using the Integrate 
operation, or you subtracts the Y-value taken at the long wavelength side of the integrated curve minus the Y-
value taken at the short wavelength side. 

Note that the Integrate and Differentiate functions are not fully reversible. Subsequent application of integration 
and differentiation to a spectral scan will return the original data apart from a scaling factor and a possible Y-axis 
offset. 
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Figure 6-9: Integrate dialogue box 

 

6.6. Anisotropy 
This data operation enables you to re-calculate spectral fluorescence anisotropy functions, both for polarised 
excitation and emission scans. 

Note that for calculating spectral anisotropy functions a measurement container is required that contains the 
original data measured with the automated anisotropy acquisition mode. If the original measurement container 
has been broken, e.g. by splitting and re-joining the data, anisotropy re-calculation will not be possible.  
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Figure 6-10: Dialogue boxes for manual excitation and emission anisotropy calculations 

6.7. Spectral Correction 
This dialogue enables you to perform spectral correction post acquisition, using stored correction files of your 
spectrometer. The correction files that are being used have been produced at the Edinburgh Instruments factory, 
or you have re-produced them yourself, refer to the instructions given in section 4.4 on page 49. 

Correction files are only available for correction, if they have been correctly assigned for. This assignment is 
made in Options >> Correction Files... . Maintaining the correct correction file assignment is critical for 
producing true spectra. 

 

Figure 6-11: Assignment of correction files 

When the active window contains one or more spectral scans, the option for manual post acquisition correction 
will be available (Data >> Correction...). The dialogue box shown in Figure 6-12 will open up. The box will show 
a list of the scans of the active data window on the left.  

One of the scans of this list can be highlighted for correction. When highlighted the software will recognise 
whether the scan is an excitation scan, an emission scan, or a synchronous scan and the option for correction 
either excitation, or emission, or both will be provided. Note that for more complex spectrometers more than one 
emission correction files may be present. Remember to select the appropriate file before applying correction. 

 

Figure 6-12: Dialogue box for manual correction 

Although correction files are typically measured with 1nm step size, the scans to be corrected can have any step 
size. An algorithm is provided to compensate for the mismatch in step sizes. 
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7. Data Operations and Analysis on Time 
Resolved Data 

A variety of the data operations and analysis tools is available to time resolved data. Some data tools are 
common to both spectral and lifetime data, others are specific. Therefore, the list of options that is available by 
clicking the pull down menu Data will vary depending on the data type and (for windows containing a set of data) 
on the properties of the data set. 

A summary of the data operation tools and data analysis options for spectral and time resolved data is given in 
section 3.7. “Data Operation and Analysis with F900” on page 42 of this User Guide. 

This section describes in detail how to use the operations and analysis tools that are provided for time resolved 
data.  

Some analysis routines are numerically complex. For more details on the lifetime data analysis used in the F900 
see the FLSP920 Series Reference Guide. 

Edinburgh Instruments also offers a software package for advanced lifetime data analysis: FAST. This software is 
sold separately. 

 

7.1. Add, Subtract, Multiply, Divide 
These operations are similar to those described for spectral data (refer to section 6.1 on page 85). 

However, pay attention that numerical operations like these may have an impact on the noise characteristics of 
the time resolved data. For instance, adding one time resolved measurement to another independently measured 
time course will maintain the Poissonian noise distribution, whereas adding an identical measurement to the 
original data will corrupt the Poissonian noise. A correct Poissonian noise distribution is important for fitting time 
resolved data. 

An Append function is not available for time resolved measurements. 

 

7.2. Scale, Normalise, Subtract Baseline, Crop Range 
These operations are similar to those described for spectral data (refer to section 6.3 on page 86). 

When using these function pay attention that this will adversely effect the noise distribution of the time resolved 
data. For instance, a non-manipulated time course might be fitted with an excellent fit and a χ2 value of 1.00. The 
same measurement, multiplied by a factor 10, can only ever have a minimum χ2 of 3.16 (=√10)! 

Another difference to spectral data is the graphical demonstration: Time resolved measurements are often 
demonstrated in a semi-logarithmic plot. This plot might not be anymore appropriate after the data operation has 
been applied – the resulting data window might appear to be empty. Change over to linear scale and/or Scale 
from Zero (via Plot Options) to retrieve the measurement. 

 

7.3. Reverse 
In some cases it might be necessary to reverse the time resolved measurements in respect to the time axis. For 
instance, reversing the time axis is desirable for lifetime measurements that were recorded in reverse mode with 
the memory not automatically taking care of the reverse operation. 

For reversing data, simply select the Reverse operation and press Apply or OK. 
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Figure 7-1: Reverse data dialogue box 

 

7.4. Anisotropy 
This data operation enables you to re-calculate the time resolved fluorescence anisotropy function from polarised 
time resolved emission measurements. 

The Anisotropy option is only available if the active data window contains either two ( IVV(t) and IVH(t) ), or four ( 
IVV(t), IVH(t), IHV(t) and IHH(t) ) polarised measurements. If only IVV(t) and IVH(t) are present in the active window, the 
dialogue box for calculating the anisotropy (see Figure 7-2) will contain a default G-factor of 1.000. You may wish 
to edit this. If all four polarised measurements are present, then the G-factor will be calculated (using IHV(t) and 
IHH(t) ) and displayed as default. 

It is possible to calculate the time resolved fluorescence anisotropy curve, even if the active data window is not an 
original measurement container. This way manually acquired polarised lifetime traces can be used to generate 
the time resolved anisotropy curve. To do this you need to enter the correct polariser orientations into the 
properties of the raw measured data. Access the measurement properties (right mouse click >> Properties), 
tick the Edit values box (on the bottom right of the file properties window) and then set the Polariser values to 0o 
and 90o, respectively.  

 

Figure 7-2: Calculation of the time resolved anisotropy function, using IVV(t) and IVH(t) 
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7.5. Tail Fit Analysis 
Use Exponential Tail Fit Analysis to fit a sample decay to a model function with one, two, three or four 
exponential terms. The fit will produce lifetimes, pre-exponential factors, a numerical value for a background level, 
and other derived parameters. To learn more about the numerical fitting algorithm and about the meaning of the fit 
parameters, refer to the FLSP920 Series Reference Guide. 

Use the Exponential Tail Fit Analysis only to analyse sample decay measurements that are not (or not 
significantly) affected by the instrumental response function. Tail fit analysis will only produce meaningful results, 
if the sample is allowed to decay without further “disturbance” by excitation. 

Figure 7-3 below shows – on the example of two different measurements “A” and “B” – the selection of a suitable 
tail fit region (region with white background). The tail fit region excludes the time period for which the IRF is still 
present. For obtaining proper fit results, the far end of the tail that only contains detector background and noise, 
but no valuable information on the decay kinetics, should also be excluded. 

 

Figure 7-3: Tail fit regions, two different examples 

 

To perform a tail fit... 
1. Ensure the active window contains only one sample decay measurement, or a sample decay 

measurement with additional IRF. 

2. Inspect your sample decay measurement and decide whether a good model function to fit to would be a 
single exponential decay, or a function that contains more than a single exponential term. Decay 
processes that are likely to be of single exponential nature are recognised by a sloping straight line in a 
semi-logarithmic plot (see tail fit region of decay “A” in Figure 7-3). Decays that deviate from a straight 
line (see tail fit region of decay “B” Figure 7-3) will not be satisfactory fitted with a single exponential 
term. 

3. Use the Zoom function to select the tail fit region. 

4. Select Data >> Exp.Tail Fit. This will open up a the dialogue box as shown in Figure 7-4. The fitting 
range shown on top of the dialogue box is inherited from the zoom in step 3 above, provided the 
zoomed region starts at, or beyond, the peak of the decay. If the zoomed region starts before the peak 
of the curve, then the Fitting Range From value will automatically be set to the peak of the curve. 
Remember, the peak is not necessarily the most appropriate start of the fitting range. The fit range for a 
tail fit should start when the IRF is completely finished.  

5. Enter your estimate for the first lifetime, τ1. This value will serve as a starting value in the following fitting 
process. A sufficiently good estimate for τ1 can be made by looking at the original data: Remember that 
for a single exponential decay the lifetime τ  is the time it takes to decay from 100% to 37% (0.367=1/e). 
Even if your judgment of the decay was that the decay is more complex than single exponential (see 
step 2 above) it is probably a good idea to start with a single exponential fit. The fit result of the single 
exponential trial will provide you with information about the estimate of a potential second lifetime 
component. 
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Figure 7-4: Tail fit dialogue box 

6. You do not need to enter an estimated for the background value A. If this box is left blank the fit will be 
started with an initial background of Zero. The background A is a numerical value that accounts for a 
constant detector background, or for a very long underlying photoluminescence signal that has built-up 
as a consequence of the repetition rate of the light source. 

7. Click Apply to start the fit. 

8. The fit result will be presented almost instantly. The fit result will comprise:  

o an updated fit-plot which contains the raw data, the fitted function (file suffix F1), and the residual 
function (file suffix F1R). The plot also contains a display of the fitted lifetime τ1 and of the fit quality 
parameter χ2.  

o An updated fit dialogue box, containing the calculated lifetime, τ1, the calculated pre-exponential 
factor, B1, the asymptotic standard errors for these two parameters, the calculated background, A, 
and the goodness of fit (or chi-squared), χ2

. 

9. You now need to make an evaluation of the quality of the fitted result, based on two parameters; 

(1)  the value of the χ2: For a good fit this should be close to Unity. (*) 

(2)  the residuals (shown in the fit plot): For a good fit they should are randomly distributed around Zero. 
 
Figure 7-5 shows as satisfactory single exponential fit result of decay “A” of Figure 7-3. In contrast, 
Figure 7-6 (showing a tail fit result of decay “B” of Figure 7-3) is an example for an unsatisfactory fit 
result.  
 

10. Repeat the fitting process, if the fit result was not satisfactory. Add a second exponential lifetime, τ2 , 
this will test for a double exponential model. Repeat with three and four exponential terms, if necessary. 

Fit results of models with 2, 3 and 4 exponential components will show a Rel% figure that is different 
from 100%, provided none of the pre-exponential factors is negative. The Rel% figure states the 
intensity contribution of each of the exponential components to the overall fluorescence intensity. 

11. When you are happy with the fit you can print the results directly from within the dialogue box (Print), or 
you can send the data to the clipboard, either as text or as image (Copy as Text, Copy as Image), for 
use in other software applications. To copy the fit plot, close the tail fit dialogue box, then press Ctrl+C 
on the graph. 

 

Fit results (file suffix F1) and residuals (file suffix F1R) may be reviewed any time later by looking up the 
properties of the files with suffices F1 and F1R, respectively. The properties of the residuals file also contain 
extended fit parameters, such as the Durbin-Watson parameter. 

 

 

 
(*) The theoretical value is Unity, provided the data have pure Poissonian noise, the fitting range has been appropriately 
selected, and the chosen model is a correct description of the measured decay. 
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Figure 7-5: satisfactory tail fit 

 

                     

Figure 7-6: unsatisfactory fit 
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7.6. Reconvolution Fit Analysis 
Use Reconvolution Fit Analysis to fit a measured sample decay to a model function with one, two, three or four 
exponential terms. The fit will produce lifetimes, pre-exponential factors, a numerical value for a background level, 
and other derived parameters. In contrast to the Tail Fit Analysis described in the previous section, where only the 
decay was analyised, Reconvolution Fit Analysis extract the lifetime parameters from the whole time resolved 
sample measurement, including the rising edge of the sample response. This way shorter lifetimes, that may even 
be shorter than the pulse width of excitation, may be reliably extracted. 

In order to do numerical reconvolution, not only a measurement of the sample decay is needed, but also an 
accurate measurement of the IRF. For a more detailed description of the numerical reconvolution, refer to the 
FLSP920 Series Reference Guide. 

Figure 7-7 below shows – on the example of two different measurements “A” and “B” – the selection of a suitable 
fit region suitable for Reconvolution Analysis (region with white background). Note that – in contrast to Tail Fit 
Analysis – the region of the IRF is included. This way all information of the sample decay can be processed 
during the analysis. This is clearly beneficial for the analysis of a decay as shown in the example “B”, but even 
can reveal a short lifetime component of the measurement example “A”. 

 

Figure 7-7: Fit regions for Reconvolution Fit Analysis 

 

To perform a tail fit... 
1. Ensure the active window contains one sample decay measurement and the corresponding IRF. 

2. Inspect your sample decay measurement and decide whether a good model function to fit to would be a 
single exponential decay, or a function that contains more than a single exponential term. Decay 
processes that are likely to be of single exponential nature are recognised by a sloping straight line in a 
semi-logarithmic plot (see decay “A” in Figure 7-3). Decays that deviate from a straight line (see decay 
“B” Figure 7-3) will not be satisfactory fitted with a single exponential term. 

3. Use the Zoom function to select the tail fit region. This should include the region of the IRF, otherwise 
refer to the previous section for Tail Fit Analysis. 

4. Select Data >> Exp. Reconvolution Fit... This will open up a the dialogue box as shown in Figure 7-8. 
The fitting range shown on top of the dialogue box is inherited from the zoom in step 3 above.  

5. Enter your estimate for the first lifetime, τ1. This value will serve as a starting value in the following fitting 
process. A sufficiently good estimate for the start value (for a single exponential fit) is 1/10 of the full 
scale of the fitting range. You will get experience in finding a suitable start value for τ1. It is also good to 
know that any lifetime estimate that is between 1/10 to 10 times of the fit results will be sufficiently good 
for a successful single exponential fit. For fits with 2, 3 and 4 exponential terms, however, the estimates 
have to become more and more accurate. 

1 010

110

210

310

0 20 40 60 80 100 120 140 160 180
Time/ns

010

110

210

310

410

0 20 40 60 80 100 120 140 160 180
Time/ns

p y, j y p

A B 



Data Operations and Analysis on Time Resolved Data  

Photonics Division                                                                                            99 

                                                  

Figure 7-8: Reconvolution Fit dialogue box 

12. You do not need to enter an estimated for the background value A. If this box is left blank the fit will be 
started with an initial background of Zero. The background A is a numerical value that accounts for a 
constant detector background, or for a very long underlying photoluminescence signal that has built-up 
as a consequence of the repetition rate of the light source. 

13. Click Apply to start the fit. 

14. The fit result will be presented almost instantly. The fit result will comprise:  

o an updated fit-plot which contains the raw data, the fitted function (file suffix F1), and the residual 
function (file suffix F1R). The plot also contains a display of the fitted lifetime τ1 and of the fit quality 
parameter χ2.  

o An updated fit dialogue box, containing the calculated lifetime, τ1, the calculated pre-exponential 
factor, B1, the asymptotic standard errors for these two parameters, the calculated background, A, 
and the goodness of fit (or chi-squared), χ2

. 

15. You now need to make an evaluation of the quality of the fitted result, based on two parameters; 

(1)  the value of the χ2: For a good fit this should be close to Unity. (*) 

(2)  the residuals (shown in the fit plot): For a good fit they should are randomly distributed around Zero. 
 
Figure 7-9a and Figure 7-10a show unsatisfactory single exponential fit results for decay “A” and “B”, 
respectively. It is clear from the look of the residuals that a fit with more than a single exponential model 
function would give better results.  
 

16. If you are not satisfied with a single exponential fit, repeat the fitting process with an added second, 
third, or even fourth exponential lifetime.  

Figure 7-9b and Figure 7-10c show satisfactory fits for the decays “A” and “B”. 

17. When you are happy with the fit you can print the results directly from within the dialogue box (Print), or 
you can send the data to the clipboard, either as text or as image (Copy as Text, Copy as Image), for 
use in other software applications. To copy the fit plot, close the tail fit dialogue box, then press Ctrl+C 
on the graph. 

Fit results (file suffix F1) and residuals (file suffix F1R) may be reviewed any time later by looking up the 
properties of the files with suffices F1 and F1R, respectively. The properties of the residuals file also contain 
extended fit parameters, such as the Durbin-Watson parameter. 

During fitting, two potential error messages may be displayed:  
(1)  “A matrix singularity occurred during fitting”: One of your estimated lifetime guesses was two small, enter a 
value that is bigger and repeat the fit. 
(2)  “A suitable fit was not found after 500 iterations”: The fitting process was not convergent and was stopped 
after 500 iterations. This error occurs typically when trying to fit complex decays and the initial guesses are not 
sufficiently close to the “true” values. Another problem may be a mismatch between the decay and the IRF, i.e. 
the measured IRF does not represent the real function that was responsible for generating the measured ssample 
decay. 
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Figure 7-9a: Single exponential reconvolution fit of example decay “A”  

 

 

Figure 7-9b: Double exponential reconvolution fit of example decay “A” 
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Figure 7-10a: Single exponential reconvolution fit of sample decay “B” 

 

Figure 7-10b: 2-exponential reconvolution fit of sample decay “B” 

 

Figure 7-10a: 3-exponential reconvolution fit of sample decay “B” 
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7.7. Autocorrelation 
The facility to calculate the autocorrelation function of the residuals will be available, if either a fit plot, or a 2D 
display of a residual curve is in focus. If this is given, the autocorrelation function may be calculated via Data >> 
Autocorrelation... .  

Upon opening of the dialogue box, simply click APPLY to calculate the autocorrelation function. The function will 
be displayed in a new window and the file will carry the extension suffix 1RA, 2RA, etc, for single, double, etc fits. 

7.8. TRES Data Slicing 
TRES-Map measurements (refer to section 5.5 on page 75) can be converted into time resolved emission (or 
excitation) spectra by “slicing”. The slices represent spectra of the sample’s emission for given time windows. 
These spectra can provide valuable information as they show the dynamics of the emission during the sample’s 
decay process. 

To convert a TRES-Map measurement into TRES ... 
1. Click Data >> TRES data slicing .... This will open up a dialogue box as shown in Figure 7-11. 

2. Define Start time, Stop time, and No. of slices. Update the Current Slice Setting Information by 
using the Apply button. This will not yet generate the data slices. You can control the width of the data 
slice by changing one of the three input parameters. 

3. You may wish to set up each slice individually. You can do this by accessing the Advanced setup. 

4. Press OK to process the data slicing. A new window will be created, and the spectra within the new 
graph will be labelled with the starting time of each data slice. 

                     

Figure 7-11: TRES-Map with dialogue for data slicing 
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Formulas and Definitions 
 

Definitions of Steady State Excitation Anisotropy 

Excitation anisotropy  
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−

=        (1) 

Total fluorescence excitation spectrum  )(I)(I)(I excVHexcVVexcT λλλ 2+=        (2) 

G-factor  
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Definitions of Steady State Emission Anisotropy 

Emission anisotropy  
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=         (4) 

Total fluorescence emission spectrum  )(I)(I)(I emVHemVVemT λλλ 2+=         (5) 

G-factor curve  
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λ
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Definitions of Time Resolved Fluorescence Anisotropy 

Time resolved fluorescence anisotropy  
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Total fluorescence decay 
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 ma = magic angle 
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Exponential Decay Kinetics (example: 3-exponential model function) 

Exponential model function 
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Relative concentration of the second 
component 
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Relative fluorescence intensity of the second 
component, as a percentage 
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Average lifetime of the entire fluorescence 
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Reconvolution of the Fluorescence Decay Model 

 

Exponential model function  ∫ −=
t

'dt)'tt(R)'t(E)t(S
0

      (14) 

 S(t) – measured fluorescence decay 

 E(t) – measured instrumental response function 

 R(t) – theoretical sample decay model function 
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Glossary 
Acronym Definition 

CCD Charge-Coupled Device 

EHT extra-high tension  

EPL Picosecond pulsed diode laser 

EPLED Picosecond pulsed LED 

IRF Instrument response function 

MCP-PMT Multi-Channel Plate Photomultiplier 

MCS Multi-Channel Scaling 

NIR Near Infrared 

NIR-PMT Near Infrared Photomultiplier 

PMT Photomultiplier 

TCSPC Time-Correlated Single Photon Counting 

TRES Time-Resolved Emission Spectra 

TRES-Map Map of Time Resolved Measurements for the purpose of generating TRES 

UV Ultraviolet 

VUV Vacuum UV. Ultraviolet radiation absorbed by air 
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